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PREFAZIONE > CREAZIONE PROGETTO [ENNEN

PREFAZIONE

IShapeX & lo strumento software per configurare il sistema IDom. E un software studiato per gli
installatori, ed ha come obiettivo rendere semplice e veloce la creazione della rete domotica. Con
IShapeX si configurano i driver dei dispositivi, gli indirizzi, eventuali azioni personalizzate, e
I'aspetto grafico dell’interfaccia web.

L'utente finale non € in grado di modificare il progetto e I'architettura della rete domotica. Tale
compito e riservato all'installatore. Si suggerisce pertanto di non fornire il software IShapeX
all’'utente finale.

Per interagire col sistema domotico |'utente utilizza I'interfaccia web IDom. L’accesso avviene via
browser web tramite smartphone, tablet, pc; oppure scaricando I'app dedicata per dispositivi
Android/iOS.

REQUISITI DI SISTEMA

Sistema operativo Windows 7 ———
2GB RAM
200MB spazio su disco fisso

PRIMA CONNESSIONE

I dispositivi IDom al primo avvio hanno un indirizzo IP fisso e predefinito, per
dettagli su come modificare tale indirizzo si suggerisce di consultare: Appendice
B - Configurare indirizzo IP.
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GUIDA ALL'USO

Un flusso di lavoro tipico prevede una serie di passaggi da seguire:

Creazione progetto = Drivers = Dispositivi 2 Punti = Ambienti 2 Mappe

CREAZIONE PROGETTO

Schermata di avvio del programma:

ishapeX 1.6.8.419 - Non Connesso N

File Configura Mappe  Strumentt  Finestre 2

_‘:\T? -.__‘_5_-.'? L"Lg;? | Y ! -._I'I-.

Non Connesso

Si identificano i seguenti elementi:

e Titolo della finestra contenente la versione del software e l'indirizzo dell’host a cui e
connesso. Nell’esempio: IShapeX 1.6.8.419 — Non Connesso

e Barra dei menu. Nell’esempio: File | Configura | Mappe | Strumenti | Finestre | ?
* Barraicone rapide.

e Areadilavoro.

Barra di stato. Nell’esempio: Non connesso

Per iniziare un nuovo progetto € necessario connettersi al dispositivo IDom (host) che memorizza
le configurazioni. Ci sono due modi per connettersi al dispositivo: in rete locale o in remoto
attraverso servizio MylDom (disponibili per gli installatori abilitati).
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CONNESSIONE ALL'HOST — RETE LOCALE

Selezionare dalla barra dei menu : File > Connetti

Si apre la finestra di configurazione connessione.

-
Connessione

Database

Host 127.0.0.1

Lavora offline

Connetti ] [ Annulla

Si accede via rete locale direttamente tramite I'indirizzo IP dell’host IDom.

In alternativa si puo scegliere di configurare il sistema in modalita offline, lavorando sul proprio pc,
senza essere connessi all’host IDom. Per farlo basta spuntare la casella Lavora offline.

Host Indirizzo IP della macchina IDom.

127.0.0.1 (default)
IShapeX in esecuzione sulla macchina IDom.

192.168.20.88 — Esempio

IShapeX in esecuzione su laptop in rete locale (IP laptop
192.168.20.80) e macchina IDom (IP 192.168.20.88)
collegata alla medesima sottorete.

Lavora offline Salva la configurazione sulla macchina locale

Connetti Si connette alla macchina

Annulla Chiude la finestra
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CONNESSIONE REMOTA ALL’HOST — MYIDOM

Ogni installatore abilitato al servizio MylDom puo connettersi ad un dispositivo attraverso il cloud
MylIDom. L’installatore ha in elenco solamente le proprie macchine.

Selezionare dalla barra dei menu : File > Myldom

Si apre la finestra di selezione del dispositivo. Fare click e scorrere I'elenco, selezionando la
macchina desiderata. Le macchine sono elencate per ID della licenza (esempio 1D15031717) ed
indirizzo pubblico (esempio marco rossi.myidom.it).

Available items

Remote host I j

| Connetti I Annulla |

Fare click su Connetti per collegarsi al dispositivo.

Requisiti necessari per usufruire del servizio di connessione remota: A

« Il software IShapeX, in possesso dell‘installatore, deve essere abilitato per i
dispositivi IDom installati presso i clienti.

« Il software IShapeX deve poter accedere alla rete internet.

e Il dispositivo IDom, installato dal cliente, deve essere acceso e poter
liberamente accedere ad internet.

« L'utente deve abilitare I'Assistenza Remota (icona verde nell’interfaccia
web utente - impostazioni, vedere paragrafo successivo).
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ABILITARE/DISABILITARE LA CONNESSIONE REMOTA

Per motivi di privacy la connessione remota puo essere disabilitata dall’'utente. Per farlo I'utente
deve aprire I'interfaccia web di IDom (http://mionome.myidom.it/idom oppure [indirizzolP]/idom)
ed accedere alla sezione impostazioni.

L’aspetto dell’icona Assistenza Remota determina lo stato attuale dei permessi:

Il tecnico pud accedere

Accesso NON consentito
Il dispositivo IDom non e

orrLne  collegato alla rete internet

Fare click sull’icona per cambiarne lo stato: abilitare/disabilitare I’accesso remoto.

DISCONNETTI

Una volta che le operazioni di manutenzione ed assistenza tecnica sono terminate il tecnico puo
scollgarsi dalla macchina selezionando la voce: File > Disconnetti.

Oppure facendo click sull’icona nella barra dei menu.
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GESTIONE PROGETTO

Una volta connesso alla macchina IDom sono possibili una serie di azioni dalla barra dei menu.

NUOVO PROGETTO

Selezionare: File > Nuovo progetto
Viene creato un nuovo progetto.

Una prima finestra avvisa che i dati del progetto attuale verranno cancellati. Selezionando Sl i dati
verranno persi. Una seconda finestra chiede se si vogliono mantenere i dati storici. Selezionando SI
tutto lo storico dei dati andra perso.

IMPORTA PROGETTO

Selezionare: File > Importa progetto

E possibile importare un progetto salvato precedentemente. Selezionare il file dalla finestra Apri.

ESPORTA PROGETTO

Selezionare: File > Esporta progetto

Il progetto corrente viene esportato in un file con estensione .idm

Prima di modificare un progetto esistente si suggerisce di farne una copia. In caso
di problemi sara possibile ripristinare il progetto originale importandolo -_
nuovamente.
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MODIFICA LINGUA

Il software IShapeX ¢ disponibile in lingua italiana ed inglese. Per cambiare la lingua selezionare la
voce dal menu: File > Lingua > Italiano (default).

La modifica della lingua dal menu File riguarda solamente I‘ambiente di
configurazione di IShapeX. Non influisce in alcun modo sulla lingua dell’interfaccia -_
web di IDom.

E possibile configurare la lingua dell’interfaccia web dalla finestra dei parametri del
progetto. Configura > Parametri > Lingua

INFORMAZIONI SUL PRODOTTO

Selezionando la voce < ? > dal menu e possibile accedere alle voci:

Informazioni su: visualizza la versione del software, I'intestatario della licenza ed il numero
corrente di punti e drivers memorizzati.

Info licenza: dettagli della licenza



GUIDA ALL'USO > CONFIGURAZIONE DRIVERS

CONFIGURAZIONE DRIVERS

Il sistema IDom comunica con i dispositivi fisici installati usando dei driver, dei processi in
esecuzione sulla macchina IDom. Esiste un driver per ciascuna famiglia di dispositivi (KNX, Modbus
TCP, ...). Non & possibile per un driver comunicare con famiglie diverse dalla propria.

Un driver gestisce, indipendentemente dal numero, tutti i dispositivi della medesima famiglia.

E possibile gestire installazioni miste, con famiglie differenti, a patto che sia configurato un driver
per ciascuna famiglia.

Esempio
Installati: n°2 controllori Modbus TCP + n°1 controllore KNX
Drivers configurati: Modbus TCP + KNX

Aprire la finestra drivers selezionando Configura > Drivers

Ogni modifica nella finestra drivers (aggiunta, modifica, rimozione) richiede il A
riavvio dei servizi di sistema, al fine di per renderla disponibile.
Selezionare Strumenti > Riavvia DBE.net
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FINESTRA DRIVERS

Si identificano due aree principali:
e Elenco drivers configurati — sul lato sinistro.
* Impostazioni del driver selezionato — sul lato destro.

Le icone in alto a sinistra gestiscono I’elenco dei driver:

|:d Aggiungi nuovo

Salva configurazione

U@

Annulla modifiche

Elimina driver selezionato

B

Chiude finestra

La casella di selezione Tipo imposta la famiglia del driver.



GUIDA ALL'USO > CONFIGURAZIONE DRIVERS

iShapeX 1.6.8.419 - 127.0.0.1 - Nuovo progetto - [Drivers]
sl Fle Configura Mappe Strumenti Finestre 2

- Q@ BEW

-/~ Dati Driver

Non attiva ] Avvio manuale = Livello di log

—
I

* Ordina per nome " Ordina per tipo

Tipo

Indirizzo IP | Porta IP |
Mote

Connesso a: ' 127.0.0.1 ' - Nome progetto: " Nuovo progetio '

AGGIUNGERE DRIVER

Fare click sull’icona Aggiungi driver

Riempire i campi secondo le specifiche:

id Codice alfanumerico univoco del driver, senza spazi.
Esempi:
drvAudio
drvModBus

Nome Nome driver, esplicativo, anche diverso da Id

Tipo Selezionare dall’elenco la famiglia del driver

Non attivo Se selezionato: disattiva temporaneamente |'avvio del

driver. Tutti i dispositivi gestiti dal driver saranno esclusi
dal sistema
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Avvio manuale Di default & disattivo.
Se selezionato: il driver & attivo ma non in esecuzione.
Usato in caso di debug dell’applicazione.
Non modificare se non espressamente indicato.

Livello di log Imposta la tipologia di log registrati dal sistema
Error: solo errori
Info (default): errori ed informazioni
Event: informazioni legate ad eventi
Debug: tutti i log a livello di programmazione

Indirizzo IP Parametro fisso a 127.0.0.1 (default)

Porta IP Porta di comunicazione della rete TCP/IP. Viene definita
in automatico dal software.
Non modificare se non espressamente indicato.

Note Spazio libero per appunti
Ogni modifica nella finestra drivers (aggiunta, modifica, rimozione) richiede il A
riavvio dei servizi di sistema, al fine di renderla disponibile.

Selezionare Strumenti > Riavvia DBE.net

Una volta aggiunti i driver necessari (uno per famiglia di dispositivi), si puo chiudere la finestra e
passare alla fase successiva.

La documentazione relativa ai drivers supportati & presente nella seconda sezione ,oo
del presente manuale. Si consiglia una lettura attenta delle specifiche prima di
passare alla fase di configurazione dei dispositivi in campo.
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ESEMPIO

Esempio Driver THEBUS

id drvTHEtest
Nome driverTHEBUSesempio
Tipo THE BUS (seriale)

Porta IP

9001
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CONFIGURAZIONE DISPOSITIVI

| dispositivi sono i controllori presenti nell’installazione. Ad esempio potrebbero essere dei PLC
collegati in Modbus TCP o dei pannelli collegati in seriale.

IDom comunica con i dispositivi attraverso i Driver, descritti precedentemente.
Ciascun dispositivo deve essere associato ad un driver.

Aprire la finestra dispositivi selezionando Configura > Dispositivi

Ogni modifica nella finestra dispositivi (aggiunta, modifica, rimozione) richiede il A
riavvio dei servizi di sistema, al fine di renderla disponibile.
Selezionare Strumenti > Riavvia DBE.net

Non & possibile aggiungere dispositivi se non & stato configurato precedentemente ?
almeno un driver (€ escluso dal conteggio il driver multimedia). -

documentazione relativa ai drivers supportati &€ presente nella seconda sezione del
presente manuale.

Si consiglia una lettura attenta delle specifiche prima di passare alla fase di
configurazione dei dispositivi in campo.

In base al tipo di driver associato saranno configurabili parametri differenti. La ‘,ao
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FINESTRA DISPOSITIVI

Si identificano due aree principali:
* Elenco dispositivi configurati — sul lato sinistro.
* Impostazioni del dispositivo selezionato — sul lato destro.

Le icone in alto a sinistra gestiscono I’elenco dei dispositivi:

Aggiungi nuovo

Salva configurazione

Annulla modifiche

Elimina dispositivo selezionato

Chiude finestra

B oy D

s File Configurs  Mappe  Stumenti Fineste

P QLB G

—Dati Di

itivo

Non attivo

10
MNome

Driver
Timelut

Poll Delay

Utilizza Falcon

FE

& Parity

Username

Password Dispositivo

Estensione Img

MNote

Connesso a: ' 127.0.0.1 ' - Nome progetto: * Nuovo progetto




AGGIUNGERE DISPOSITIVO
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Fare click sull’icona Aggiungi dispositivo

Riempire i campi come da specifiche del driver/progetto, tenendo conto che alcuni parametri

possono essere 0 meno presenti, in base al tipo di driver associato.

Di seguito una panoramica dei parametri piu usati. Si rimanda alla sezione drivers per maggiori

informazioni.

ELENCO PARAMETRI

Id Codice alfanumerico univoco del dispositivo
Esempio:
dvcModBus
Nome Nome dispositivo (diverso da Id)
Driver Selezionare dall’elenco il driver da associare
Non attivo Se selezionato: disattiva il dispositivo
Note Spazio libero per appunti
TimeOut Tempo di attesa di risposta del dispositivo
Retry Numero tentativi di connessione
Poll Delay Frequenza aggiornamento dei dati acquisiti dal campo

Polling Interval

Intervallo tra le letture dei dati

Indirizzo IP Indirizzo IP v4 del dispositivo
Porta IP Porta TCP del dispositivo
Com Port Numero della porta COM (seriale) utilizzata

Com BaudRate

Velocita bit/s della porta COM (seriale) utilizzata
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Com Parity Tipo di parita della comunicazione COM (seriale)

Com Data bits Lunghezza del dato in bit

Com Stop bits Lunghezza dello stop in bit
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ESEMPIO

Tre configurazioni di dispositivo.

Esempio Modbus RTU

Id dvcModBusTest
Nome deviceTestModBusTCP
Driver drvModBusTest
TimeOut 200

Retry 2

Poll Delay 50

Com Port 1

Com BaudRate 38400

Com Parity None

Com Data bits 8

Com Stop bits 1

Esempio IRtrans

Id dvclRtest

Nome deviceTestIRtrans

Driver drvIRtest

TimeOut 1000

Retry 5

Poll Delay 30000

Indirizzo IP 192.168.20.8
Esempio ModBus TCP

Id dvcTestModbusRTU

Nome deviceTestModbusRTU

Driver drvModBus

TimeOut 1000

Retry 5

Poll Delay 100

Indirizzo IP 192.168.20.88

Porta IP 502
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CONFIGURAZIONE PUNTI

| punti sono gli elementi presenti nell'installazione definibili come ingressi o uscite (digitali o
analogiche). Un punto luce a due stati: acceso/spento &€ ad esempio un’uscita digitale. Un
termostato invece puo essere un considerato come un insieme di uscite/ingressi analogici.

DI digitale ingresso (bit solo lettura)
DO  digitale uscita (bit lettura e scrittura)
Al analogico ingresso (word 16bit solo lettura)

AO  analogico uscita (word 16bit lettura e scrittura)

In base alla tipologia del driver, ed all’architettura del progetto, un controllore gestisce uno o piu
punti. Allo stesso modo, puo capitare che in reti complesse, un punto rappresenti informazioni
composte.

Aprire la finestra drivers selezionando Configura > Punti

Ogni modifica nella finestra Punti (aggiunta, modifica, rimozione) richiede il riavvio A
dei servizi di sistema, al fine di renderla disponibile.
Selezionare Strumenti > Riavvia DBE.net

Non & possibile aggiungere punti se non & stato configurato precedentemente

almeno un dispositivo. -
In base al tipo di driver associato la parametrizzazione dei punti sara differente. c,o
Si consiglia una lettura attenta delle specifiche drivers prima di passare alla fase di

configurazione dei punti.



GUIDA ALL’'USO > CONFIGURAZIONE PUNTI

FINESTRA PUNTI

Si identificano due aree principali:
* Elenco dispositivi configurati — sul lato sinistro.
* Tabella punti del dispositivo selezionato — sul lato destro.

Le icone in alto a sinistra gestiscono la tabella punti visualizzata.

Salva dati

Annulla modifiche

Elimina punto selezionato (intera riga)

Chiude finestra

O U

ishapeX 1.6.8.419 - 127.0.0.1 - IDOM Demo 146 - [Punti]
s File Configura Mappe Strumenti Finestre 7

—Dispositivi
Blocchi Variabili (%]
i e Bl o Y et = Eors autataret o et ta

Connesso a: " 127.0.0.1 ° - Nome progetto: ' IDOM Demo 146 °

Scorciatoia da tastiera: CTRL + Ins copia la riga/cella.
Scorciatoia da tastiera: SHIFT + Ins incolla la riga/cella -
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AGGIUNGERE PUNTO
Selezionare dall’elenco il dispositivo che andra a gestire i punti che si vogliono aggiungere.
In automatico la tabella si aggiorna con i punti configurati (se gia presenti).

Fare click sulla prima riga vuota e modificare le voci in base alle specifiche/parametri del progetto.
| parametri base elencati di seguito sono comuni per tutti i driver.

ID Identificativo univoco del punto

Nome Nominativo del punto

Note Spazio libero per appunti

Script Script associati al cambiamento di stato del punto. Per maggiori

informazioni si rimanda al capitolo dedicato agli script in LUA.

Maggiori dettagli sulla configurazione punti nella sezione drivers.

IMPORTA PUNTI

Nel caso di progetti di grandi dimensioni € possibile compilare i punti al di fuori del software
IShapeX e poi procedere all'importazione degli stessi. A tal fine sono presenti una serie di wizard
dedicati per alcuni tipi di protocollo: INIM, SimpleHome, Telldus, THE Bus.

Per avviare i wizard dedicati, selezionare: Configura > Importa Punti > [...]
FILE CSV

E inoltre possibile esportare/importare tutti i punti del progetto corrente su un file csv (*.csv)
generico, tramite apposito wizard.

Per esportare i punti, selezionare Configura > Importa Punti > Dump Tags

Per importare i punti, selezionare Configura > Importa Punti > Load Tags
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IMPORTARE UN PROGETTO GENERICO (FILE .CSV)

Grazie alla funzione di import/export file CSV & possibile caricare un progetto generico di un
qualsiasi bus all’'interno della finestra punti di IShapeX. Questo scenario risulta particolarmente
interessante quando il software di configurazione del bus non prevede in modo nativo
un’esportazione dei punti (ad esempio MyHome di BTicino o il software ETS per KNX).

Si suggerisce di procedere come segue:
1. Aggiungere e configurare i driver necessari — finestra Drivers.
2. Aggiungere e configurare i relativi dispositivi utilizzati — finestra Dispositivi.

3. Aggiungere manualmente i punti di cui non si vuole procedere con I'importazione nella
fase successiva — finestra Punti.

4. Esportare i punti del progetto corrente: Importa punti > Dump Tags

In questo modo il file .csv generato dall’esportazione contiene automaticamente le
colonne corrette ed i nomi dei driver/dispositivi sui quali i punti devono essere importati.

5. Aprire il file .csv appena generato con un qualsiasi editor o con un software tipo Microsoft
Excel, OpenOffice Calc o simili.

Aggiungere tutti i punti rimanenti dell'impianto, prestando particolare attenzione ai valori
delle colonne. Salvare i file cosi redatto (che potra essere utilizzato sia come copia di
backup, sia come base per futuri ampliamenti dell'impianto).

Fare attenzione a non eliminare colonne o le righe relative al formato del file (queste sono
contraddistinte da un carattere #).

6. Procedere ad importare i punti all’interno di IShapeX: Importa punti > Load Tags
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CONTEGGIO PUNTI LICENZA

Per il conteggio dei punti licenza si fornisce di seguito una tabella di riferimento, in cui ciascun oggetto
viene valutato in termini di punti (tag) utilizzati.

La seguente tabella & uno specchietto riepilogativo di supporto all‘installatore al A
fine di individuare il taglio della licenza IDom da utilizzare.

Il numero di punti necessari potrebbe essere superiore a quello stimato, e si basa
sulle specifiche tecniche del modulo I/O impiegato e sulla release software del
driver. Si suggerisce di sovrastimare le reali necessita e leggere attentamente la
documentazione specifica.

Punti LICENZA Indirizzo su bus
Bticino Luci On/Off =1 1 indirizzo A + PL
Dimmer =1 1 indirizzo A+ PL
Automatismi Tapparella su/giu = 2 2 indirizzi A+ PL
Termoregolazione Termostato =1 1 indirizzo ZONA
Gestione energia Lettura corrente =1 1 indirizzo PL

Lettura tensione =1
Lettura potenza=1
Lettura energia=1

Gestione energia Singola disattivazione = 1 1 indirizzo PL
Punti LICENZA Indirizzo su bus
KNX Luci On/Off =1 1 indirizzo stato
1 indirizzo comando
Dimmer =1 3 indirizzi stato
2 indirizzi comando
Automatismi Tapparella su/giu = 2 2 indirizzi stato
2 indirizzi comando
Termoregolazione Termostato =3 1 indirizzo stato temp.
1 indirizzo stato setpoint temp.
1 indirizzo comando setpoint temp.
1 indirizzo stato modo
1 indirizzo comando modo

Punti LICENZA Indirizzo su bus
THE BUS Luci On/Off =1 1 indirizzo modulo e uscita
Dimmer=1 1 indirizzo modulo e uscita
Automatismi Tapparella su/giu = 2 2 indirizzi modulo e uscita
Termoregolazione Termostato =1 1 indirizzo modulo e uscita




DUEMMEGI

Modulo IR

INIM

Punti LICENZA
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Indirizzo su bus

Luci On/Off =1 1 indirizzo modulo
Dimmer=1 1 indirizzo modulo
Automatismi Tapparella su/giu =1 1 indirizzo modulo

Termoregolazione

Termostato = 2

1 indirizzo modulo
1 indirizzo per tag servizio

Punti LICENZA

Singolo modulo =1

Indipendente dal numero di comandi
mappati e configurati

Punti LICENZA

Aree

Singolaarea=1

Sensori

Singolo terminale =1
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AMBIENTI

La configurazione degli ambienti riguarda I'aspetto grafico dell’interfaccia web che utilizzera
I'utente. Si assume che la rete domotica sia gia stata configurata a livello di drivers, dispositivi, e
punti.

Gli ambienti configurati (ed abilitati) sono visualizzati nel menu principale dell’interfaccia web e
tipicamente rappresentano delle stanze, delle aree, delle superfici dell’edificio o anche
raggruppamenti funzionali.

Selezionare: Configura > Ambienti.
Ogni eventuale modifica degli ambienti richiede il salvataggio prima di chiudere la finestra attiva.

Nel caso di inserimento di nuovi punti € necessario chiudere e riaprire la finestra ambienti.

Prima di salvare la configurazione, per confermare le modifiche nei campi nella A
griglia, & necessario premere INVIO dopo la digitazione del valore.
In alternativa, dopo la digitazione del valore, fare click su un‘altra colonna.
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La finestra € composta da due tabelle principali: elenco ambienti ed elenco controlli.

Le icone in alto a sinistra gestiscono la finestra ambienti.

B Salva dati

5 Annulla modifiche

li Chiude finestra

Facendo click sulla riga relativa ad un ambiente viene popolata la tabella Controlli ambiente

contenente i controlli configurati per tale ambiente.

iShapeX 1.6.8.419 - 127.0.0.1 - IDOM Demo 146 - [Ambienti]
ol File Configura Mappe Strumenti

Finestre 7

o @ yoflv

Tipo

Energy management

—Controlli ambiente

Connesso a: " 127.0.0.1 " - Nome progetto: ' IDOM Demo 146 '
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CONFIGURAZIONE AMBIENTE

Identificare la prima riga disponibile nella griglia Ambienti e fare click sulla cella desiderata per
modificare la voce.

Tipo Imposta I'icona visualizzata nell’interfaccia web.

Nome Nome dell’ambiente. Viene visualizzato al di sotto dell’icona
nell’interfaccia web.

Posizione Progressivo numerico che definisce I'ordine di visualizzazione.
(Parte da 1, ed i numeri pil bassi vengono posti in alto).

Scenari Se selezionato: I'ambiente e disponibile nella configurazione
scenari.

No Web Se selezionato: I'ambiente esiste ma non ¢ visualizzato
nell’interfaccia web ad icone. Pud comunque essere utilizzato
nelle mappe.

Una volta creato un ambiente e possibile associare i relativi controlli.
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AGGIUNTA CONTROLLI AMBIENTE

In base alla tipologia di controllo alcune voci possono non essere disponibili.

Controllo Imposta il tipo di controllo, e relativa icona.
Nome Nome del controllo visualizzato nell’interfaccia web.
Posizione Progressivo numerico che definisce [l'ordine di

visualizzazione. (Parte da 1, ed i numeri piu bassi
vengono posti in alto).

Comando utente Imposta I'aspetto del controllo con cui l'utente
interagisce via interfaccia web.
Esempi:

interruttore on-off, slider, interfaccia tapparella, ...

Punto Associa uno o piu punti della rete domotica al comando
dell’interfaccia grafica.

Scenari Se selezionato: I'ambiente e disponibile nella
configurazione scenari.

Protezione Se selezionato: la modifica del controllo via interfaccia
web e protetta da password (psw default: nimda).

No Web Se selezionato: il controllo esiste ma non & visualizzato
nell’interfaccia web. Pud0 comunque essere utilizzato
nelle mappe.
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TIPOLOGIA CONTROLLO

Di seguito i dettagli per tipo di controllo [in completamento].

Controllo Comando utente Descrizione
Luce On / Off Interruttore acceso / spento standard
Slider Dimmer 0 - 100%
Comando Bi-tag
Termostato FantiniCosmi
Generico
RGB SliderRGB Interruttore acceso / spento
Incremento luminosita
Impostazione del colore
Allarme Allarme
Videocamera Video Apre un riquadro nella pagina controlli
contenente 'ultima immagine acquisita
Area centrale Area singola
Automatismi Su/ Giu Comando su / giu semplice
KNX BT
Automatismi

Tapparella Vimar

Gestione energia

Gestione carichi

Finestra personalizzata: assorbimento
attuale, tensione di utilizzo, ...
Disattivazione manuale carichi

Display

Analogico sola
lettura

Analogico

Visualizza valore numerico acquisito

Collegamento web

Collegamenti web

Controlli generici

On / Off

Comando Bi-tag

Irrigazione

Pagina generica

Telecomandi

Telecomando TV

Telecomando generico su interfaccia web

Ventilazione

VMC

Trend

Trend
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MAPPE

La configurazione delle mappe riguarda l'aspetto grafico dell’interfaccia web che utilizzera
I'utente. Le mappe sono un modo alternativo per visualizzare i controlli configurati. Per accedere
alle mappe sull’interfaccia web IDom fare click sul logo di IDom.

Per configurare le mappe in IShapeX, selezionare: Mappe > Map Editor.

FINESTRA MAPPE

La finestra € composta da tre aree principali: elenco mappe, elenco controlli, area mappa.

Le icone in alto a sinistra gestiscono la finestra mappe.

B Salva dati
[J Chiude finestra

iShapeX 1.6.8.419 - 127.0.0.1 - IDOM Demo 146 - [Map Editor]
File Configura Mappe Strumenti Finestre 7

> @ FBRW

—Main plan

Controlli (DBE.net)

Connesso a: ' 127.0.0.1 ' - Nome progetto: ' IDOM Demo 146 '
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ELENCO MAPPE

Visualizza I'elenco ordinato delle mappe configurate. E possibile cambiare I'ordine di scorrimento
selezionandone una e facendo click sui pulsanti Su e Giu.

Nuovo Crea nuova mappa

Elimina Elimina mappa

Rinomina Cambia nome alla mappa

Immagine sfondo Imposta I'immagine della mappa

Default Se selezionato: la mappa viene visualizzata all’apertura

della pagina web.

AGGIUNGERE CONTROLLI

Creare le mappe desiderate. Selezionarne una e procedere al posizionamento dei controlli
semplicemente trascinando I'icona del controllo desiderato sull’area della mappa.

Per eliminare I'oggetto aggiunto basta selezionarlo e premere il tasto Canc.

L'elenco dei controlli, localizzato in basso a sinistra, raggruppa gli stessi per ambiente. Per tale
motivo € necessario configurare prima gli ambienti e per ultime le mappe.

Facendo click su un oggetto/controllo della mappa, appare una breve descrizione dello stesso
nell’angolo in basso a sinistra, presso la barra di stato. Sul lato destro invece € mostrata la
posizione dell’oggetto.

Gli oggetti sono ancorati alla mappa nel loro angolo in alto a sinistra. E utile tenerne conto, in
modo da evitare disallineamenti della grafica, in seguito al ridimensionamento dell’interfaccia
web.
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ishapeX 1.6.8.419 - 127.0.0.1 - IDOM Demo 146 - [Map Editor]

File Configura Mappe Strumenti Finestre

L]
E &l

Elimina | Rinomina |

|

Meeting room
Office
Waorkroom

Immagine sfondo Default I
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Camera
&

Connesso a: " 127.0.0.1 ° - Nome progetto: ' IDOM Demo 146 "

\

Non c’é alcun vincolo tra la suddivisione per ambienti e per mappe. E compito
dell’installatore mantenere chiarezza e semplicita nel progetto. -—
I controlli presenti in una mappa possono appartenere ad ambienti differenti.




TGN GUIDAALL'USO > TELECAMERE

TELECAMERE

Se si hanno a disposizione una o piu telecamere che fornisco immagini su un indirizzo http, o
salvano un’immagine via FTP, allora & possibile configurarle in IShapeX.

Telecamera FTP Salva (a tempo o ad evento) I'immagine sul
server IDom tramite protocollo FTP.

Telecamera Snapshot L'immagine e resa disponibile tramite un URL
(URL) pubblico.

L'URL deve essere raggiungibile da qualsiasi
browser semplicemente digitandola nella
barra degli indirizzi.

Esempio:
http://192.168.70.12/img/snapshot.jpg

IDomX supporta solamente telecamere di tipo SNAPSHOT (URL). A
Le funzioni di snapshot che richiedono anche un intervento umano, tipo la
pressione di un pulsante, non sono compatibili con IDom.

Produttori di telecamere snapshot attualmente supportati:
* Axis
e DLink
* Hikvision

e Linksys

Produttori di telecamere snapshot per cui non sono stati effettuati test di compatibilita: iCamView,
Foscam, Asante, LevelOne, TrendNet,Wanscam, Aviosys, IPUX, Dahua, Edimax.
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AGGIUNGERE UNA TELECAMERA

L'aggiunta di una videocamera non richiede la configurazione di un driver, un dispositivo o un
punto. Semplicemente selezionare: Configura > Ambienti per aprire la finestra ambienti.
Aggiungere un controllo di tipo Videocamera nell’ambiente desiderato.

Fare click sulla colonna < ... > per aprire la finestra di configurazione dei parametri.

Tipo Parametri

Nome file, Configurare il nome del file o I'url.
Directory,

IP Cam Esempio:

http://mario:123@192.168.88.66/Streaming/picture

Galileo Configurare:
Canale
Indirizzo IP
Utente
Password
Refresh (espresso in secondi)

IDom DVR Configurare il canale: devdrv.

Ciascun produttore e relativo modello di telecamera utilizza una URL che puo discostarsi da
guanto mostrato, a titolo di esempio elenchiamo due modelli compatibili con il sistema IDom.

Marca Modello URL
Hikvision ~VF IR Bullet  http://x.x.x.x/Streaming/channels/1/picture
(snapshot)

Se richiesta autenticazione utilizzare:
http://USERNAME:PASSWORD@x.x.x.x/Streaming/channels/1/picture

D-Link DSC-942L http://x.x.x.x/image/jpeg.cgi
(snapshot)
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Attenzione al numero e tipologia di telecamere installate, in particolar modo la
banda occupata e risoluzione video sui sistemi IDomX.

L'interfaccia web di IDom effettua il refresh dell’immagine ogni secondo.
Alcuni modelli di telecamera salvano le immagini ogni 2 - 5 - 10 secondi,
provocando cosi un ritardo nell’aggiornamento dell'immagine.
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MULTIMEDIA

| dispositivi IDom EVO ed IDomX dispongono di un’unica uscita audio, connettore jack da 35mm
(per I'IDom EVO tale uscita € contrassegnata dal simbolo cuffie o simbolo altoparlante).

Per utilizzare il multimedia player nell’interfaccia web e necessario aggiungere e configurare il
relativo driver. Selezionare Configura > Drivers, poi fare click sull’icona Aggiungi driver e
completare i campi come da tabella seguente.

Id Codice alfanumerico del driver. Univoco.
Esempio: dryMM

Nome Nome driver:
driverMultimediale

Tipo Multimedia

Porta IP Assegnata in automatico
Esempio: 9008

Al contrario dei driver relativi alla domotica, il driver Multimediale non ha bisogno di configurare
voci quali dispositivi o punti, ma solamente il driver.

| file multimediali da riprodurre devono essere raccolti in una cartella locale (directory),
configurata su un dispositivo NAS o equivalente, e condivisi senza richiesta di credenziali
utente/password. L’indirizzo della cartella (directory) va poi configurato nella finestra dei
parametri del progetto.

Per configurare la directory selezionare dal menu: Configura > Parametri > Multimedia.

Abilita file audio Deve essere selezionato

Cartella predefinita Directory contenente i file di tipo audio. Puo
essere una cartella locale oppure un indirizzo
di rete (NAS).

Esempio:

\\192.168.100.240\music (IDom EVO)
//192.168.100.240/music (IDomX)
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Bisogna porre attenzione al tipo di dispositivo su cui si configura il driver
multimediale. In quanto cambia il modo di scrivere il percorso delle cartelle  JE——
(directory).

Dispositivi IDom EVO (s.0. Windows)
Le directory usano come separatore “\”

Esempio \\192.168.1.2\Mydocs\music

Dispositivi IDomX (s.o. Linux based)
Le directory usano come separatore “/”

Esempio //192.168.1.2/Mydocs/music
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CARATTERISTICHE E LIMITI D’USO

Il mancato rispetto dei vincoli sotto citati pud comportare un malfunzionamento A
del player multimediale e/o del sistema di supervisione (bus domotico).

File audio compatibili

.mp3 .cda .wav .wma

Limite massimo: 30 file audio per cartella
(per un massimo 4 cartelle, directory)

| nomi dei file non devono presentare caratteri
particolari o lettere accentate. In tal caso
I'esecuzione  degli stessi potrebbe  essere
compromessa.

File radio streaming

.m3u
Limite massimo: 2 file di radio streaming.

Utilizzare solamente i file radio rilasciati sul sito:
idom.it/support

L’esecuzione della radio in streaming e influenzata da
parametri quali: banda disponibile, provider servizi,
traffico dati bus domotico.

Il gestore della radio pu0 decidere di cambiare
I'indirizzo di streaming senza preavviso, causando la
mancata esecuzione.

Dispositivo NAS

Si consiglia di utilizzare il dispositivo WD myCloud per
I'archivio dei file multimediali.

I NAS deve essere acceso e disponibile online nel
momento in cui il player richiede I'esecuzione dei
brani.

Si consiglia di non archiviare in piu di n.4 cartelle
(directory)

Utilizzo negli scenari

La presenza di file audio irregolari/corrotti nelle
playlist degli scenari pudo comportare un blocco del
player e/o del sistema di supervisione.
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DRIVERS

Per comunicare con tutti i dispositivi domotici KNX bisogna utilizzare il driver:

KNX Falcon (ethernet-serial)

Le configurazioni dei controlli dipendono dal tipo di dispositivo, dall’architettura
delle rete domotica, e da eventuali aggiornamenti/modifiche del produttore del

dispositivo.

Alcune voci possono discostarsi da quanto mostrato nel presente manuale.

CONFIG. DRIVER

Tipo KNX Falcon (ethernet-serial)
Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale
Porta IP Porta TCP/IP impiegata. Parametro compilato in

automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Polling Interval

10000 (default) espresso in millisecondi

Utilizza Falcon

SELEZIONATO se sistema IDom
NON SELEZIONATO se sistema IDomX

Tipo connessione

Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

A
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Nel caso di sistema IDom standard bisogna utilizzare le librerie Falcon che vanno installate sulle
macchina stessa. Proprio per tale motivo la configurazione delle librerie deve essere eseguita
direttamente dal software IShapeX in esecuzione sulla macchina IDom.

Le librerie Falcon vengono installate e configurate in fase di preparazione della macchina IDom.
Per configurare la libreria Falcon fare click sul pulsante Falcon gestore connessioni < ... >

Si apre la finestra ETS Connection Manager.

ETS CONNECTION MANAGER

L'installatore deve conoscere in modo accurato il funzionamento del protocollo KNX ed il
significato dei parametri richiesti. Si include a scopo illustrativo una possibile configurazione.

ETS Connection Manager

~ Connessioni configuate, ~Propiieta
Tipe:  [USB

UsSe

Nome:

I~ Connessione standard

i~ Parametr di comunicazione

Dispositiva USE:

Nuovo Eliming

Annuil
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CONFIG. PUNTI

Indirizzo comando Indirizzo per invio comando
Fare click su < ... > per modificare

Indirizzo stato Indirizzo per lettura stato
Fare click su < ... > per modificare

Tipo di punto 2> KNXLUCE DO (lettura e scrittura)
Gestione di 2 stati (acceso/spento),
tipicamente impiegato per luci,
interruttori, stati

KNXDIMMER Punto analogico per i moduli dimmer

KNXAUTO Dedicato alla gestione di automatismi
quali tapparelle, veneziane ...

KNXAI_FLOAT Al (sola lettura)
Esempio: rilevamento temperatura
termostato

KNXAO_FLOAT AO (lettura e scrittura)
Esempio: set point temperatura,
soglie, ...

KNXBYTE_AO  AO (lettura e scrittura) di grandezza
byte
KNXBYTE_AI Al (lettura) di grandezza byte

Alcuni tipi di punto possono esser utilizzati per piu dispositivi. Ad esempio,
KNXLUCE é utilizzato anche per determinare la stagione di un termostato. -_
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CONFIG. AMBIENTI

Di seguito e elencata una panoramica di configurazione per i principali controlli ambiente.

Prima di salvare la configurazione, per confermare le modifiche nei campi nella A
griglia € necessario premere INVIO dopo la digitazione del valore, oppure fare click

Su un’altra colonna.

CONTROLLO LUCE

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare >

Selezionare >

Selezionare >

CONTROLLO DIMMER LUCE

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare =

Selezionare =

Selezionare =

Luce
Esempio L1
On/Off Punto luce a due stati
PuntoL1 ID del punto luce configurato
nella finestra punti.
(Esempio: PuntolLl)
Luce
Esempio L2
Slider Punto luce dimmer
PuntolL2 ID del punto luce configurato

nella finestra punti.
(Esempio: PuntolL2)



CONTROLLO TAPPARELLA
Controllo Selezionare >
Nome
Posizione

Comando utente

Punto

Selezionare >

Selezionare >

CONTROLLO DISPLAY

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare =

Selezionare >

Selezionare >

DRIVERS > KNX

Automatismi

EsTapl

KNX BT Tapparella per KNX
Automatismi

knxTapp1l ID punto di comando
tapparella configurato.
(Esempio: knzTapp1)

Display

Display analogico Visualizza il dato
sola lettura

knxAnl ID del punto configurato
precedentemente.
(Esempio: knzAn1l)

Nel caso si selezioni Comando utente = Display analogico & possibile configurare un comando
che oltre a visualizzare il dato acquisito ne permette anche la modifica. Ovviamente il dispositivo

fisico in campo deve permettere la modifica.
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CONTROLLO TERMOSTATO

Tramite bus KNX possono essere pilotati diversi tipi di termostato. Creare un controllo “ad hoc”
per ciascun modello risulta complesso, si € optato quindi di dare la possibilita all’installatore di
costruirselo partendo da dei blocchi base (campi).

| modelli creati possono poi essere esportati ed importati per essere utilizzati in altri progetti.
Inoltre possono essere impiegati anche su altri tipi di drivers.

Controllo Selezionare = Termostato

Nome

Posizione

Comando utente Selezionare > Termostato generico

Punto

[...] Fare click > Apre la finestra di configurazione del controllo
Fare riferimento al capitolo successivo CREA
OGGETTO: TERMOSTATO.

CREA OGGETTO: TERMOSTATO

La creazione di un nuovo oggetto si basa sul concetto che ogni tipo di grandezza: temperatura,
modo, set point, fa riferimento ad un canale del modulo. Ad esempio: la temperatura rilevata e
un’uscita analogica di uno specifico indirizzo del bus.

Alcuni tipi di campo sono destinati ad un uso specifico (ed un’icona grafica ben definita), come per
esempio Temperatura set point. Altri invece sono generici ed hanno un piu ampio spettro
d’azione. Di seguito I'elenco dei campi disponibili:

TA — Temperatura Aggiunge un campo valore di temperatura rilevata.
E una variabile d’ingresso (sola lettura) analogica letta
dal modulo.

SP — Temperatura set point  Mostra il campo valore set point della temperatura del
termostato. Tale valore € modificabile e prevede un
range max — min.

I campo & provvisto di tasti su/giu per
incremento/decremento del valore.
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VA - Stato valvola Campo con lo stato della valvola del termostato:
- spento: nessuna immagine
- riscaldamento: icona sole
- raffreddamento: icona neve

Al — Analog Input Imposta campo valore analogico in sola lettura.
Si pud scegliere I'unita di misura, il numero di decimali
ed il fattore di conversione.

AO — Analog Output Come per il campo Al — Analog Input ma con in piu la
possibilita, da parte dell’'utente, di cambiare il valore.
Si puo scegliere di attivare i controlli freccia su/giu che
modificano il valore a step di incremento/decremento.
Possono essere configurate delle soglie max/min.

GE — Generico Il campo generico raggruppa diversi tipi di controllo:
dal pulsante standard fino al gruppo di azioni (ad
esempio il modo del termostato o la stagione).

Per configurare un pulsante:
- NON impostare il valore del gruppo
- associare i valori attivo e disattivo

Per creare un gruppo:
- impostare ID del gruppo uguale per ogni
oggetto GE creato

L'ordine di costruzione dell’oggetto viene rispettato anche nella grafica della pagina web. Se ad
esempio viene creato un campo Temperatura ambiente e poi un campo Temperatura set point nel
browser appare prima la temperatura ambiente e poi il set point.

Il campo Stato valvole, al contrario degli altri parametri, viene sempre visualizzato sulla pagina in
alto a destra.
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FINESTRA CONFIGURAZIONE

A sinistra e presente una vista gerarchica dei campi aggiunti al controllo. A destra sono mostrati i
dettagli del campo attualmente selezionato.

Fare click col pulsante destro sulle icone per aggiungere/rimuovere i campi.

Delete elimina il campo.
Add > [...] aggiunge il campo scelto.

Facendo click sul pulsante Modelli & possibile importare/esportare dei controlli gia realizzati.

@ Configurazione termostato general purpose

r—Dettagli

Tipo controllo ITempevatula ambiente

Etichetta web INuovo elemento (TR}

Mostra in IPagina principale

Tag Stato
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DETTAGLI CAMPO

Alcuni parametri dipendono dal tipo di campo e possono non essere disponibili. [*]

Tipo controllo

Non modificabile, impostato alla creazione.

Etichetta web

Nome visualizzato sull’interfaccia web.

Mostra in

Sezione web dove viene visualizzato:

Pagina principale: pagine del controllo

Pagina avanzata: pagina dettagli controllo, si
accede facendo click su icona > nell’'interfaccia
grafica.

Tag stato

Punto da associare per lettura stato.

Tag comando

Punto da associare per invio comando.

um *

Unita di misura del valore visualizzato.

Fattore di conversione *

Moltiplica valore acquisito.

Cifre decimali *

Numero cifre decimali visualizzate.

ID gruppo *

Permette di associare pil campi sotto lo stesso
controllo (impostare lo stesso ID).

Etichetta gruppo *

Nome visualizzato del gruppo.

Valore stato attivo

Valore sul bus che determina I’attivazione

Valore attivazione *

Valore inviato dall’interfaccia web indicante lo
stato attivo.

Sola lettura *

Il valore puo essere solo letto.

Valore minimo *

Soglia minima inviata dall’interfaccia web.

Valore massimo *

Soglia massima inviata dall’interfaccia web.

Step *

Valore di incremento/decremento usato con le
freccie su/giu dell’interfaccia web.

Mostra controlli avanzati *

Abilita la visualizzazione di freccia su/giu.
Se disabilitato i valori numerici sono scritti
manualmente dall’utente
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Tag stato riscaldamento * Punto da associare per lettura stato
riscaldamento (termosifoni on/off).

Tag stato raffreddamento * Punto da associare per lettura stato
raffreddamento. (condizionatore on/off).

Valore stato riscaldamento * Valore indicante lo stato acceso ON del
riscaldamento.

Valore stato raffreddamento * Valore indicante lo stato acceso OFF del
riscaldamento.

Valore stato disattivo * Valore indicante lo stato disattivo.

Valore disattivazione * Valore per impostare disattivo un modulo.

Ogni modello di termostato puo presentare caratteristiche diverse non solo in base
ai moduli presenti ma anche al tipo di programmazione.

L'ordine dei campi mostrati su web rispetta quello di creazione. L'ordine puo
comunque essere cambiato a piacimento anche dopo, semplicemente trascinando i
controlli.
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IMPORT / EXPORT MODELLO

Se si vuole utilizzare il controllo creato precedentemente su piu stanze, o impiegarlo in progetti
differenti, IShapeX mette a disposizione due funzionalita.

Import / Export locale Esportare un modello:
(stesso progetto) - Creare il termostato base
- Fare click sul pulsante Modelli
- Appare la finestra Gestione modello
- Immettere un nome per il modello e fare
click su Salva modello
- Chiudere la finestra

Importare un modello (gia esistente):
- Fare click sul pulsante Modelli
- Appare la finestra Gestione modello
- Selezionare dall’elenco il modello
- Fare click su Apri modello
- Modificare i parametri se necessario
- Premere Ok e chiudere la finestra

Import / Export su file Esportare su file:
(progetti differenti) - Creare il termostato base
- Dalla barra dei menu, selezionare
Configura > Parametri > Template
- Selezionare tipo template: Termostato
- Fare click su Export
- Immetere un nome per il file e scegliere il
percorso. Poi fare click su Salva

Importare da file:

- Dalla barra dei menl, selezionare
Configura > Parametri > Template

- Selezionare tipo template: Termostato

- Fare click su Import

- Selezionare il file contenente i modelli
precedentemente esportati. Poi fare click
su Apri.

- Orai modelli sono disponibili nel progetto
corrente.
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Dopo aver importato un modello & importante verificare i parametri della A
configurazione. Tipicamente i punti associati (Tags) ed i valori di stato/attivazione
dipendono dal dispositivo fisico a cui si fa riferimento, di conseguenza andranno

riassegnati.
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THE BUS

Per comunicare con tutti i dispositivi THE Bus bisogna utilizzare il driver:

Driver THE Bus

Le configurazioni dei controlli dipendono dal tipo di dispositivo, dall’architettura A
delle rete domotica, e da eventuali aggiornamenti/modifiche del produttore del
dispositivo.

Alcune voci possono discostarsi da quanto mostrato nel presente manuale.

CONFIG. DRIVER

Tipo THE Bus (seriale)

Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

COM port Numero della porta COM (seriale) utilizzata.
COM baudrate Velocita bit/s della porta COM (seriale) utilizzata
COM parity Tipo di parita della comunicazione COM (seriale)
COM data bits Lunghezza del dato in bit

COM stop bits Lunghezza dello stop in bit

PC Station id ID numerico del nodo coordinatore della rete
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La macchina IDom pud connettersi al bus THE utilizzando la porta seriale RS232 oppure via USB
attraverso un convertitore USB-Seriale.

Per sapere la porta COM configurata utilizzare il gestore dispositivi di Windows (Pannello di
Controllo > Sistema > Gestione Dispositivi).

- Gestione dispositivi

File Azione \Visuglizza ?

alta ANs I NERN ? BoallES

Ll:j Lettori smart card
[=| Modem

Mouse e altri dispositivi di puntamento

B rorte (COM e LPT)
- Processori

L Schede direte

Lu" Schede video

| schermi

ZD Tastiere

g Unita disco

= Unita DVD/CD-ROM
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In aggiunta ai parametri ID e Nome & necessario compilare le seguenti voci.

Uscita/Ingresso

Indirizzo dell’uscita o ingresso sul modulo THE Bus.

Indirizzo modulo

Indirizzo (o identificativo) del modulo fisico sul THE Bus.

Gruppo Solo per punti digitali DI/DO & possibile specificare un
gruppo di appartenenza. Non ¢ obbligatorio definire un
gruppo se il punto non e gestito.

Fare click sul pulsante [...] e scrivere nelle caselle libere il
numero del gruppo/i. Sono disponibili al massimo 8
associazioni a gruppi.

Funzione Solo per uscite digitali DO, e possibile la:

Forzatura — imposta lo stato direttamente
sull’uscita del modulo, in modo forzato.

Temporizzata — esegue la temporizzazione
programmata su bus.

Tipo di punto 2>

DI Ingresso digitale

DO Uscita digitale

Al Ingresso analogico

AO Uscita analogica

AUTOMATISMO Modulo tapparella posizionale 0-100%
TERMOSTATO Modulo termostato

GRUPPO Modulo per attivazione gruppo.

(Per I'associazione ai gruppi del THE Bus
fare riferimento alla colonna Gruppo.)
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DIMMER Modulo dimmerabile
SCENARIO Modulo scenario
TEMP Ingresso analogico utilizzato solo per

temperatura termostato. Deve essere
indirizzato come il relativo termostato.

Il THE Bus permette, a livello di protocollo, di gestire massimo 31 gruppi (1..31).
Ciascun singolo punto della rete pud poi essere associato ad uno o piu dei
precedenti gruppi (massimo 8 associazioni per singolo punto).

Se non viene configurato il gruppo di appartenenza & possibile che il sistema IDom
perda lo stato del controllo (mancato aggiornamento). Ad esempio: se nel bus THE
circola un comando di gruppo che accende una luce, questa apparira comunque
spenta in IDom.

Esempio
In figura il punto di01 & associato ai gruppi 1,4,30

— e — —
iShapeX 1.6.8.419 - 127.0.0.1 - iuovo progetto - [Punti] - [of =
ol File Configura Mappe Strumenti Finestre ? -8 x
: = . 'I ’ )
5 (2 N0 Wi |6
2@ FBRW O
2 0 |H
Dispositivi- — —Punti
dvcthebus - Device | [x)
> 220 —
jin] | MNome | 4 Tipo | mnd| Gruppo | | Vel Rig
1 |[lucel Luce 1 1D0 2
diot Ingres: pu s
i 9 Associazione Tag-Gruppi
3 |[luce2 Luce 2
4 |dioz Ingres: Gruppa 1 I 1
luce3 Luce 3 I—
L Gruppo 2 4
g |luced Luce 4 |—3ﬂ
7 |thmod4des Allarme Gruppo 3
g |luces Luce 5 Gruppo 4 I—
[ g |luces Luce & I
L2 = Gruppo 5
10 |tappgiu Tappar I—
11 |tappsu Tappar Gruppo &
13 Gruppo 7 I
13 Gruppo & I
14
2 Ok | Cancel |
16
17
| 1 =
4] | <i 3

Connesso a: ' 127.0.0.1 ' - Nome progetto: ' Nuovo progetto '




DRIVERS > THE BUS

IMPORTAZIONE AUTOMATICA PUNTI

Come accennato all’inizio del manuale, e possibile importare automaticamente i punti THE Bus di
un impianto, salvando tempo prezioso ed evitando gli errori tipici della digitalizzazione manuale.

Una volta terminata la configurazione con il software EDSConfig, esportare il file (.xml) del
progetto, che verra richiesto durante la procedura di importazione.

La procedura importa automaticamente ingressi ed uscite di tutti i moduli salvati nel progetto del
bus. Bisogna quindi fare attenzione a non superare il limite stabilito nella licenza IDOM.

Durante l'importazione, nel caso di modifiche sull'indirizzamento dei moduli, gli oggetti negli
ambienti possono perdere il riferimento. In tal caso & necessario poi procedere a riassociare il
punto.

E stato utilizzato il software EDSConfig versioni 1.8.1 e 1.9.1. Eventuali moduli, ,oo
presenti nelle altre versioni, potrebbero non essere automaticamente importati.
Procedere con l'inserimento manuale.

Per avviare I'importazione fare click su: Configura > Importa punti > THE Bus

= 7 e =
ShapeX 1.6.8.419 - 127.0.0.1 - Nuovo progetis
File Configura Mappe Strumenti Finestre 7

THE BUS - Import

THE BUS import wizard

Seleziona file esportato
| L

™ Elimina punti esistenti (eventusli oggett negli ambienti perderanno il riferimento)

I~ Importa ingressi digitali (D)
Seleziona il dispositive sul guale impartare
IDewce The Bus ;I

™ Imports tutti i aruppi (RICHIEDE 21 punti in licenza)
¥ Importa solo | gruppi utilizzati su ingressi & uscite digitali (DI, DO)

e | Inizia importazione |
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E possibile configurare una serie di parametri:

Seleziona file esportato

Fare click su [...] e selezionare il file .xml del progetto
(precedentemente esportato dal software EDSConfig).

Elimina punti esistenti

Se SELEZIONATO: i punti gia presenti in IShapeX
vengono cancellati, poi procede all'importazione del
progetto.

Importa ingressi digitali

Se SELEZIONATO: importa gli ingressi digitali presenti nel
progetto.

Selezionare dispositivo
sul quale importare

Selezionare il nome del dispositivo THE Bus sul quale
verranno importati i punti.

Importa tutti i gruppi

Importa tutti i Gruppi del THE Bus (anche quelli non
utilizzati). Utilizza 31 punti dalla licenza.

Importa solo i gruppi
utilizzati su ingressi ed
uscite digitali

Importa solamente i Gruppi che utilizzano ingressi ed
uscite digitali (DI, DO).

Fare click su Inizia importazione per acquisire i punti.
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Di seguito sono elencati i principali controlli ambiente.

CONTROLLO LUCE

Controllo

Nome

Posizione

Comando utente

Punto

ON/OFF GENERICO

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare =

Selezionare >

Selezionare >

Selezionare =

Selezionare =

Selezionare =

DRIVERS > THE BUS

Luce

Esempio L1

On/Off Punto luce a due stati

PuntolL1 ID del punto luce configurato

Controlli generici

Interruttore
Forno

nella finestra punti. (Deve
essere un’uscita digitale DO).

(Esempio: PuntolLl)

On/Off generico

Punto luce a due stati

PulsanteForno

ID del punto generico DO
comandato.

(Esempio: PulsanteForno)
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CONTROLLO DIMMER LUCE

Controllo Selezionare > Luce

Nome Esempio L2

Posizione

Comando utente Selezionare > Dimmer WT Punto luce dimmer

Punto Selezionare > DimmerL2 ID del punto luce configurato
nella finestra punti.
(Esempio: DimmerL2)

[..]

CONTROLLO TAPPARELLA POSIZIONALE

Il controllo “Automatismo” consente di visualizzare ed impostare il valore di una tapparella di tipo
posizionale (cioé regolabile nella posizione da 0-100%). E necessario che il punto relativo sia di tipo
Automatismo.

Controllo Selezionare > Automatismi

Nome EsTapPos1

Posizione

Comando utente Selezionare > Tapparella WT Tapparella per KNX

Punto Selezionare > Tapl ID punto.
(Esempio: Tap1l)

[...]
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CONTROLLO TAPPARELLA SU/GIU

Con questo controllo & possibile comandare tapparelle, veneziane e tende motorizzate. E
necessario creare due punti DO, uscite digitali, per ogni tapparella: apertura e chiusura.

Controllo Selezionare > Automatismi

Nome EsTapPos1

Posizione

Comando utente Selezionare > Su/Giu Tapparella per KNX

Punto

[...] Fare click > Apre la finestra  Selezionare i punti relativi ad
di apertura e chiusura della
configurazione tapparella

Impostare Type su Interlock

CONTROLLO ATTIVA SCENARIO

Controllo Selezionare = Scenario

Nome

Posizione

Comando utente Selezionare > Scenario WT Attiva lo scenario configurato

Punto Selezionare > ScenNotte ID del punto di tipo scenario,
precedentemente configurato.

(Esempio: ScenNotte)
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CONTROLLO GRUPPO
Controllo Selezionare > Controlli
generici
Nome
Posizione
Comando utente Selezionare > Gruppo WT Attiva lo scenario configurato
Punto Selezionare > GruppoA ID del punto di tipo gruppo
precedentemente configurato.
(Esempio: GruppoA)
[..]
CONTROLLO TERMOSTATO
Controllo Selezionare > Termostato
Nome
Posizione

Comando utente Selezionare > Termostato WT  Attiva lo scenario configurato

Punto Selezionare > Termol ID del punto di tipo
termostato precedentemente
configurato.

(Esempio: Termol)
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INIM ALARM

Il driver INIM consente di comunicare con le seguenti centrali di allarme:

Centrale 10-50
Centrale 10-100 [test non effettuato]
Centrale 515 [test non effettuato]

Utilizzare il driver:

Inim Alarms (ethernet)

Il driver INIM gestisce la sicurezza direttamente tramite la relativa centrale. A
Il sistema IDom non memorizza in nessun caso la password utente. L'utente deve

digitare la password ad ogni comando inviato. Per tale motivo queste funzionalita

negli scenari non sono gestite.

CONFIG. DRIVER

Tipo Inim Alarms (ethernet)

Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente, scegliere una porta libera, non
utilizzata da altri drivers.
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CONFIG. DISPOSITIVO

In aggiunta ai parametri standard quali ID e Nome & necessario configurare:

Poll Delay

Frequenza di aggiornamento dei valori dal campo
del driver

Indirizzo IP

Indirizzo IP della centrale

Porta IP

Porta IP della centrale

Type

Modello della centrale di allarme:
1050
10100
515

CONFIG. PUNTI

In aggiunta ai parametri ID e Nome & necessario compilare le seguenti voci.

Indirizzo

Indirizzo sul modulo della centrale.

Tipo

Tipo di punto sulla centrale.

AREA — Punto area proprietario della centrale
SENSOR — Sensore (zona) proprietario della centrale

Dato

Indirizzo DATO in centrale INIM (configurabile solo per punti
di tipo SENSOR). Se si utilizzano zone doppie e/o zone su
tastiera, tale campo puo differire da “indirizzo”.

Tipo Term.

Tipologia del punto terminale (configurabile solo per punti
di tipo SENSOR).

0: ingresso

1: uscita
2:in/out

3: doppio

4: non utilizzato
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Si suggerisce di importare automaticamente i punti della centrale di allarme, invece di aggiungerli
manualmente uno per volta.

IMPORTAZIONE AUTOMATICA PUNTI

E possibile, tramite wizard dedicato, importare automaticamente i punti della centrale di allarme
INIM.

Per prima cosa & necessario generare il file .xml utilizzato per I'importazione. Utilizzare il software
Smart League, fornito da INIM. Selezionare dal menu del programma Database/Esporta e salvare
il file .xml.

In IDom vengono importati solo i punti delle aree e delle zone utilizzate nelle tastiere configurate
nel progetto. Punti relativi ad altre aree/zone non verranno importati.

Per avviare I'importazione fare click su: Configura > Importa punti > INIM

ShapeX L6.8.419 - 127.0.0.1 - Huove

File Configura Mappe  Strumenti inestre 7

2@ LIBRW Y

Inim import Wizard

Inim import wizard

Selezions file esportato

Connes: [~ Elimina punti esistenti (eventuali ogoetti negli ambienti perderanna il riferimenta)

™ Inserisci aree & sensori nell'ambiente (cggett gia presenti saranno sostituiti):

|aTie |




DRIVERS > INIM ALARM

E possibile configurare una serie di parametri:

Seleziona file esportato  Fare click su [...] e selezionare il file .xml del progetto
(precedentemente esportato dal software Smart league).

Elimina punti esistenti Se SELEZIONATO: i punti gia presenti in IShapeX vengono
cancellati. Poi procede all'importazione del progetto.

Inserisci aree e sensori  Se SELEZIONATO: importa automaticamente gli oggetti in
nell’ambiente uno degli ambienti esistenti, selezionabile da elenco.
Eventuali oggetti gia presenti verranno sostituiti.

Fare click su Inizia importazione per acquisire i punti.

Lasciando non selezionata |'opzione Elimina punti esistenti i punti gia presenti Ioo
verranno aggiornati automaticamente. I relativi ID dei punti, al fine di evitare
perdite dei riferimenti agli oggetti presenti negli ambienti, non saranno sostituiti.

presenti nella pagina e salvare la griglia vuota.
A questo punto procedere con |'importazione automatica come sopra.

Prima di iniziare l'importazione dei punti si suggerisce di cancellare tutti quelli ‘,oo

Attenzione: al fine di importare correttamente tutti i sensori e le aree in IShapeX, A
tutti i terminali della centrale devono essere lasciati mappati nel progetto
SmartLeague, anche quelli non utilizzati (non collegati).

Ad esempio: per la centrale 1050, tutti e 50 i terminali vanno lasciati mappati,
anche se poi fisicamente si procedera a collegarne solo una parte.

Questo nota e importante, perché permette una corretta mappatura degli indici dei
terminali nel file .xml esportato. File che poi verra importato in IShapeX con il
presente wizard.



CONFIG. AMBIENTI

Di seguito sono elencati i principali controlli ambiente.

CONTROLLO AREA CENTRALE

Controllo

Nome

Posizione

Comando utente

Punto

[ ]

Selezionare =

Selezionare >

Selezionare >

CONTROLLO SENSORE/ZONA

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare >

Selezionare >

Selezionare =

Area centrale

DRIVERS

> INIM ALARM

Areal

Inim Area Area centrale INIM

PAreaA ID del punto di tipo area della
centrale INIM.
(Esempio: PAreaA)

Allarme

Allarmel0

Inim Sensore

Sensore centrale INIM

PSen10

ID del punto di tipo sensore

della centrale INIM.

(Esempio: PSen10)



DRIVERS > INIM ALARM

SEGNALAZIONE ALLARMI INTERFACCIA WEB

A livello utente (interfaccia web) gli allarmi vengono notificati attraverso un codice colori.

colore standard Stato normale

sfondo: ARANCIO Memoria allarme o memoria
manomissione

sfondo: ROSSO Stato di Allarme e segnalazione di
apertura dal sensore

Un serie di etichette applicate sugli oggetti, neillustra lo stato.

nessun Area non inclusa
testo

P Area inserita parziale

T Area inserita totale

| Area inserita come immediata

MA Memoria allarme

MT Memoria manomissione — Tampered




DRIVERS > BTICINO

BTICINO

Per comunicare con i dispositivi appartenenti al bus F452 di BTicino bisogna utilizzare il driver:

BTicino (ethernet)

CONFIG. DRIVER

Tipo BTicino (ethernet)

Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Il dispositivo che permette la comunicazione sul bus & il web server Bticino: F452 oppure F454.

Indirizzo IP Indirizzo IP del modulo F452 (oppure F454)

Porta IP Porta TCP/IP utilizzata dal modulo F452 (o F454)
Di default &: 20000

Attenzione, dopo aver cambiato le impostazioni sul modulo F452 o F454 e A
necessario spegnere il bus Bticino, attendere un minuto e riaccendere poi i vari
dispositivi, questo per consentire un corretto aggiornamento degli indirizzi IP e

relativa comunicazione con il supervisore IDom.



DRIVERS > BTICINO

CONFIG. PUNTI

In aggiunta ai parametri ID e Nome & necessario compilare altri campi. | campi sono mostrati
disponibili in base al tipo di punto definito.

Tipo = ... Maggiori dettagli nella tabella successiva
Conf. A Ambiente punto

Conf. PL Punto luce nell’ambiente

Conf. ZA Ambiente per punti termo

Conf. ZB Punto in ambiente termo

Conf A Ambiente punto diffusione sonora

Conf Pf Punto di diffusione sonora nell’ambiente
Montante Numero identificativo, nel caso siano

configurati montanti

Tipo sorgente/
Modulo scenario

Tipo > BTALARM SENSORE Sensore allarme su ambiente

BTAMBIENTI Ambiente per diffusione sonora. All'interno si
ha la diffusione sonora associata BTAMPLI e
BTSORGENTI.

BTAMPLI Amplificatore all’interno dell’ambiente

BTAUTO Automatismo (tapparelle, persiane, su/giu)

BTAUTOAMB Comando punti automatismo, relativo ad un
ambiente

BTAUTOGR Comando punti automatismo, non

necessariamente parte di un ambiente




DRIVERS > BTICINO

BTLUCI Punti luce on/off

BTLUCIAMB Comando punti luce, relativo ad un ambiente

BTLUCID Punti luce dimmer

BTLUCIDAMB Comando punti luce dimmer, relativo ad un
ambiente

BTLUCIDGR Comando punti luce dimmer, non

necessariamente parte di un ambiente

BTLUCIGR

BTPOWER CORRENTE Lettura corrente

BTPOWER ENERGIA Lettura energia

BTPOWER POTENZA Lettura potenza

BTPOWER PUNTI Punto fisico del modulo per il controllo carichi

BTPOWER TENSIONE Lettura tensione

BTSCENARI Punto attivazione scenario

BTSORGENTI Sorgenti impianti audio (radio/aux)

BTTERMOZONA Modulo scenario




DRIVERS > BTICINO

CONFIG. AMBIENTI

Di seguito sono elencati i principali controlli ambiente.

CONTROLLO LUCE

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare =

Selezionare >

Selezionare >

CONTROLLO DIMMER

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare =

Selezionare >

Selezionare >

Luce

Lucel

BT On/Off Punto luce a due stati

PuntolL1 ID del punto luce configurato
nella finestra punti.
(Esempio: PuntolLl)

BT Dimmer

Dimmerl

BT Dimmer

PDimmerl ID del punto luce dimmer.

(Esempio: PDimmerl)



DRIVERS > BTICINO

CONTROLLO AUTOMATISMI
Controllo Selezionare 2> Automatismi
Nome Tapparellal
Posizione

Comando utente Selezionare 2> BT Automatismi

Punto Selezionare > PAutol ID del punto luce dimmer.

(Esempio: PAutol)

CONTROLLO SCENARI

| dispositivi BTicino consentono la creazione di scenari dinamici controllati da un unico punto.

Controllo Selezionare > BT Scenari
Nome ScenarioA
Posizione

Comando utente Selezionare > BT Scenario

Punto Selezionare >  AttScenA ID del punto termostato.

Esempio: AttScenA




BN DRIVERS > BTICINO

CONTROLLO GESTIONE ENERGIA

Controllo Selezionare > Gestione Energia
Nome GestoreEnergia
Posizione

Comando utente Selezionare > BT Gestione Energia

Punto
[...] Fare click > Apre una finestra dove inserire i punti di:
Tensione
Corrente
Potenza
Energia

Oltre a questi € possibile selezionare i punti di
controllo energia configurati.

Assegnare alla voce Tensione, Corrente, Potenza, Energia i corrispettivi punti di tipo: BTPOWER
TENSIONE, BTPOWER CORRENTE, BTPOWER POTENZA, BTPOWER ENERGIA precedentemente
configurati nell'impianto.

Alle voci Punto 1 ... Punto 8 si assegnano, se presenti, i punti dell'impianto che si occupano della
disabilitazione dei carichi (BTPOWER PUNTI). Si ricorda che ad esempio il punto 3, permette di
selezionare tutti i punti BTPOWER PUNTI che hanno un indirizzo sul bus pari a 3.

[ Punti Gestione Energia BTicino

FAS201TENSIONE |
[F45201CORRENTE |

Comards ‘FABZ]TEDRHENTEJ
|

el FAS201FOTENZA v

[F45207ENERGIA =]

Tensione

Energia

Punto 1 F45201PUNTO1 ﬂ Punto5 -
Punto 2 FAS201PUNTO2 v Punio 6 =i
Punto 3 FWUNTD3 L‘ Punta 7 l ﬂ
Punto 4 b2 Punto 8

|

oK I Annulla




CONTROLLO TERMOSTATO
Controllo Selezionare >
Nome
Posizione

Comando utente

Punto

[ ]

Selezionare >

Selezionare >

CONTROLLO MULTIMEDIA

Termostato

Termol

BT Termoregolazione

DRIVERS > BTICINO

PTermoReg

ID del punto termostato.

Esempio: PTermoReg

| dispositivi BTicino consentono la diffusione sonora all’interno dell’abitazione. Il sistema IDom
utilizza 3 punti per interfacciarsi al sistema: BTSORGENTI, BTAMPLI, BTAMBIENTE, descritti

precedentemente in configurazione punti.

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare >

Selezionare >

Selezionare >

Multimedia

MM1

BT Sound

BTambienteS

ID del punto termostato.

Esempio: BTambienteS
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Z-WAVE

NON DISPONIBILE PER IDom EVO

Per comunicare con i dispositivi radio Z-Wave bisogna utilizzare il driver:

ZWave (radio)

CONFIG. DRIVER

Tipo ZWave (radio)

Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Il dispositivo che permette la comunicazione sul bus e il web server presente nel modulo F452.

COM Port Porta COM utilizzata dalla scheda radio interna di
IDom.
Default: 1 (sistema IDomX)

CONFIG. PUNTI

L'acquisizione dei punti Z-Wave presenti nell’installazione avviene attraverso I'esplorazione dei
dispositivi in rete.

Le tipologie di punti attualmente gestite dal software IShapeX sono Al, AO, DI, DO. Ciascun punto e
poi corredato da una serie di informazioni, se disponibili, (ad esempio: label, units, index).



DRIVERS > Z-WAVE

AGGIUNGERE UN DISPOSITIVO

Nella colonna di sinistra selezionare il dispositivo Z-Wave precedentemente configurato.

Fare click su Add device. Si apre una finestra con una griglia contenente i dispositivi gia installati
(se presenti). IShapeX e pronto a rilevare il dispositivo.

Consultare la guida d’uso o installazione del dispositivo acquistato e seguire la procedura di
inclusione (Adding/Including). Tipicamente si tratta di premere un pulsante un numero definito di
volte, oppure tenerlo premuto per un certo tempo.

Il dispositivo aggiunto appare nella finestra Add Device. Fare click su OK e riavviare i servizi di
sistema, selezionare Strumenti > Riavvia DBE.net.

Fare click su Leggi rete. La tabella punti si aggiorna con quelli del dispositivo Z-Wave aggiunto.

iShapeX 1.6.8.419 - 127.0.0.1 - Nuovo progetto - [Punti]

3 File Configura Mappe Strumenti Finestre ?

A =01 P

EEXIE]

Dispositivi

! dvcBACnet - Device BACnet Leggi rete | ‘ Add device Del device

1D | Mome | Nodeid | Objtype | Index

i H

cmd | Lebel [ units |Instance| Mote | Script

Add Device B

id [ type |
1 Static PC Controller

14 General Thermostat V2

1% Muliievel Poner Swtch

12
13

Connesso a: ' 127.0.0.1 " - Nome progetto: ' Nuovo pr




TS DRIVERS > Z-WAVE

RIMUOVERE UN DISPOSITIVO

Fare click su Del device. Si apre una finestra con una griglia contenente i dispositivi gia installati.

Consultare la guida d’uso o installazione del dispositivo acquistato e seguire la procedura di
esclusione (Removing/Resetting). Tipicamente si tratta di premere un pulsante un numero definito
di volte, oppure tenerlo premuto per un certo tempo.

Il dispositivo rimosso scompare dall’elenco della finestra Remove Device. Fare click su OK e
riavviare i servizi di sistema, selezionare Strumenti > Riavvia DBE.net.

Fare click su Leggi rete. La tabella punti mostra solo quelli dei dispositivi Z-Wave inclusi.

iShapeX 1.6.8.419 - 127.0.0.1 - Nuovo progetto - [Punti]
3 File Configura Mappe Strumenti Finestre ?

@B RwY

EEXIE]

 Dispositivi Punti - = =
dvcBACnet - Device BACnet ‘ Leggi rete | ‘ Add device | Del device

| ‘IDl Mome | Nodeid | Objtype | Index | cmd | Label | wnits | Instance| note
£

1. |

2

H

Remove Device x|

id | type

1 Static PC Controller

14 General Thermostat V2
16 Mulilevel Power Switch

Connesso a: ' 1

Dopo ogni inclusione/esclusione di dispostivi € importante riavviare i servizi di
sistema, via Strumenti > Riavvia DBE.net

La lettura della rete, I'aggiornamento e |'acquisizione dei dispositivi sono procedure
che possono richiedere anche alcuni minuti per il completamento. Non c'é
segnalazione all’'utente sul termine della procedura.



DRIVERS > IR-TRANS

IR-TRANS

Per comunicare con i dispositivi IR-trans € necessario configurare il driver:
IRTRANS (ethernet)

| dispositivi emettitori ad infrarossi devono essere configurati tramite il software fornito. In ciascun
dispositivo € necessario mappare la libreria dei comandi. Ossia la relazione comando — sequenza di
impulsi.

| dispositivi sono forniti di una libreria standard. Se il dispositivo con cui si vuole comunicare non e
in elenco si puo procedere con I'auto-apprendimento dei comandi. Maggiori dettagli nel capitolo
“Mappatura libreria comandi”.

CONFIG. DRIVER

Tipo IRTRANS (ethernet)

Indirizzo IP Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Il dispositivo che permette la comunicazione sul bus e il web server presente nel modulo F452.

Indirizzo IP Indirizzo IP del dispositivo emettitore.
Porta IP Porta COM utilizzata dalla scheda radio interna di
IDom.

Default: 21000.




BN DRIVERS > IR-TRANS

CONFIG. PUNTI

Sono disponibili diverse tipologie di punti, a seconda del dispositivo da comandare: televisore,
condizionatore.

Indirizzo Nome della libreria configurata nella memoria flash del
dispositivo.
Tipo TV REMOTE - Televisore

A/C REMOTE - Condizionatore / fanair
SLIDE REMOTE

CONFIG. AMBIENTI

CONTROLLO IR-TRANS

Controllo per condizionatori di tipo fan-air con trasmettitore infrarossi.

Controllo Selezionare = Telecomandi
Nome ComandoFanAir
Posizione

Comando utente Selezionare > Condizionatore  Condizionatore tipo fan-air

Punto Selezionare > Irzxt120 ID del punto configurato.

(Esempio: irzxt120)
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MAPPATURA LIBRERIA COMANDI

Il software e le funzioni descritte qui di seguito non sono parte del sistema IDom o A
del software IShapeX. Per dettagli ed assistenza tecnica specifica fare riferimento
al sito del produttore.

Nel caso si voglia comunicare con un dispositivo non presente nelle librerie standard, si procede a
mappare ogni singolo comando.

Si considera per esempio un condizionatore fan-air provvisto di telecomando. Si procede
configurando il dispositivo IR-Trans come ricevitore e tramite il telecomando del fan-air si inviano i
segnali al ricevitore IR-Trans, che memorizzera il codice. Ad acquisizione terminata la libreria sara
pronta per essere utilizzata.

Per prima cosa collegare il dispositivo IR-Trans via cavo USB al computer. Avviare poi il software.
Un’icona di notifica appare in basso a destra. Per accedere alle varie opzioni fare click col pulsante
destro.

Startup Parameter

IP Assign (LAM Only)
IRConfig (USB/WiFi)

Start IRServer

About ...
Exit

Fare click su Start IRServer. Dopo fare click sulla voce Learn IR Code.

La finestra richiede una serie di parametri ma quelli essenziali sono il database dove memorizzare i
comandi, ed il nome di ciascun nuovo comando. Fare click su Learn Command e poi premere sul
telecomando il pulsante che si vuole far acquisire (telecomando a vista). La casella di testo Code si
completa con il codice IR del comando letto (una serie di 0 ed 1).

Dopo aver acquisito i comando desiderati fare click su Finish Learning.
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F| IRServer Parameters

IP Assign (LAN Only)

|ie 'l Gpen | Creste Remote
IR Config {USB/WiFi)

: Add linked _ Import
|B Timings Command IRTrans Hex Reload IR Database
|a1 Commands Add CCF AddR5232 Stop IRServer
Hexcode Command
Restart IRServer

»;i |NomeComando| | Learn Command

Diagnostics

IR Carrier | |Leam command with timing :I Loglevel 0 {Off) -
ﬂ Detected IR Commands.

IR RCV Il.' 38 kHz
Learn long button presses I™ calibration |OFF Yl

leanB&OCode [ MNosort [ Mapouttoggiebit [ Send IR Code
Rmeout [ooms v] RTokr [osns ] Wat ["3 TR E T

| Device Database

IR Translation

Code
Device |0: IRTrans WiFi [USE]
HTML Pages

Adress | I l
Lol o
Get IR Hexcode

Analog Inputs

About ...
Exit

Prima di uscire dal programma e necessario salvare sulla memoria flash del dispositivo IR-Trans la
libreria di comandi precedentemente acquisita. Fare click su Device Database.

--|rt|an5 |
8- kathre Deselect

Properties

IRServer Parameters
IP Assign (LAN Only)

- sonaviskeyboard
' IR Config (USB/WiFi)

[¥-trash
tvsamsung Reload IR Database

Stop IRServer

Restart IRServer
Diagnostics

Loglevel 0 (Off) =

Detected IR Commands

V' |RDB receive active 1o

|RDE receive via LAN relay ™ Relaiscontrol via LAN refay | Learn IR Code
E:
]

Devica DB active

Send IR Code

weot [ [ | e

Hend IH Cote vz (RDHE Actions
Lirie by Jine e=nd vis IRDE Actions
Defaut Action  [%r %\
Size IRDB 128K 7] SshsOK JOK Status Emor [ERAOR te IR Translation
HTML Pages

Filename 5 Load | Save | Clear Hash | Sl o
Device  [0.0-WE.09.31- R Sit Analog Inputs

About ..,

Fare click col pulsante destro sul nome della libreria creata, poi Select.

Per scrivere la libreria sul dispositivo fare click su Flash.
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DUEMMEGI

Per comunicare con i dispositivi appartenenti al bus Duemmegi utilizzare:

Duemmegi Modbus (seriale)

CONFIG. DRIVER

Tipo Duemmegi Modbus (seriale)

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Si prosegue a configurare il dispositivo.

COM port Numero della porta COM (seriale) utilizzata.
COM baudrate Velocita bit/s della porta COM (seriale) utilizzata
COM parity Tipo di parita della comunicazione COM (seriale)

Default: NONE

COM data bits Lunghezza del dato in bit
Default: 8

COM stop bits Lunghezza dello stop in bit
Default: 1

PC Station id ID numerico del nodo coordinatore della rete




LN DRIVERS > DUEMMEGI

La macchina IDom pud connettersi al bus Duemmegi utilizzando la porta seriale RS232 oppure via
USB attraverso un convertitore USB-Seriale.

Per sapere la porta COM configurata utilizzare il gestore dispositivi di Windows (Pannello di
Controllo > Sistema > Gestione Dispositivi).

- Gestione dispositivi

File Azione \Visuglizza ?

alta ANs I NERN ? BoallES

Ll:j Lettori smart card

=] Modem

Mouse e altri dispositivi di puntamento

B rorte (COM e LPT)
- Processori

L Schede direte

Lu" Schede video

| schermi

ZD Tastiere

g Unita disco

= Unita DVD/CD-ROM
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CONFIG. PUNTI

In aggiunta ai parametri ID e Nome & necessario compilare altri campi. | campi sono mostrati
disponibili in base al tipo di punto definito.

Indirizzo Indirizzo dell’uscita o dell’ingresso
all'interno del modulo Duemmegi.

Uscite analogiche AO

Uscite digitali DO

Tapparelle

Dimmer

Per gli elementi sopra indicati bisogna
sommare 512 al numero configurato sul
dispositivo.

Esempio
uscita analogica: 2 224512 =514

Solo per uscite digitali DO

Oltre a sommare +512 bisogna anche
aggiungere l'indicazione del bit a cui si fa
riferimento.

Esempio
1° bit, uscita digitale: 4 > 4 + 512 =516.1

Indirizzo modulo Indirizzo del modulo fisico Duemmegi.
Durata Impulso Solo per uscite digitali DO, e possibile
(ms) impostare un tempo dopo il quale I'uscita

ritorna allo stato iniziale di OFF.

ID DFCL [DEPRECATI]
Valvola Inv.
Valvola Est.

Bisogna sommare 512 a tutti i punti che sono delle uscite, e con questo ci si
riferisce non soltanto ad uscite digitali, ma anche tapparelle e dimmer. -—
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Tipo 2>

DI Ingresso digitale
DO Uscita digitale

Al Ingresso analogico
AO Uscita analogica

TERMO DUEMMEGI

[DEPRECATO] Termostato

SONDA DUEMMEGI [DEPRECATO] Sonda temperatura, modulo
DFTA

TAPPARELLA DUEMMEGI  Tapparella, modulo DFTP

TAG SERVIZIO Tag di servizio. Da utilizzare abbinato ad un

tipo di punto DFCT.

DIMMER DFDM/DFDI
DIMMER DFDV

Dimmer

DO (DIMMER DFDV)

Relay del dimmer DFDV

DFCT

Termostato, modulo DFCT

Richiede punto TAG SERVIZIO in aggiunta




CONFIG. AMBIENTI

Di seguito sono elencati alcuni controlli particolari.

CONTROLLO DIMMER “DFDM/DFDI” e DIMMER “DFDV”

Controllo

Nome

Posizione

Comando utente

Selezionare =

Selezionare >

Punto Selezionare >
[...]

CONTROLLO TAPPARELLA
Controllo Selezionare =
Nome
Posizione

Comando utente

Punto

Selezionare =

Selezionare =

Luce

L1 dimmer

DRIVERS > DUEMMEGI

DIMMER DFDM/DFDI  oppure
DIMMER DFDV
PuntolL1 ID del punto Iluce

Automatismi

Tapparella sala

dimmer configurato.

(Esempio: PuntoL1)

Duemmegi
Tapparella

PuntoTappl

ID del

punto configurato

come tapparella.

(Esempio: PuntoTappl)
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CONTROLLO TERMOSTATO “DFCT”

Controllo

Nome

Posizione

Comando utente

Punto

Selezionare >

Selezionare >

Selezionare >

Termostato

Cronotermo

Duemmegi DFCT

PuntoTermo

ID del punto termostato
configurato.

(Esempio: PuntoTermo)
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MODBUS

Due driver sono dedicati alla gestione dei dispositive Modbus:
Driver Modbus RTU (seriale)

Driver Modbus TCP/IP (ethernet)

Alcune configurazioni possono discostarsi da quanto descritto nel presente A
manuale. Si suggerisce di fare riferimento alla documentazione tecnica del
produttore dei dispositivi.

CONFIG. DRIVER

Tipo Modbus RTU oppure Modbus TCP/IP

E possibile utilizzare contemporaneamente
entrambi i driver con l'accortezza di configurare
due differenti driver: uno di tipo Modbus RTU e
I’altro come Modbus TCP/IP.

Indirizzo IP Default: 127.0.0.1 (localhost) — Non modificare

Porta IP Porta TCP/IP
Il parametro viene configurato in automatico.
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CONFIG. DISPOSITIVO

Modbus RTU (seriale)

Completare i parametri:

COM port Numero della porta COM

COM baudrate Velocita porta COM bit/s

COM parity Parita nella comunicazione
COM data bits Lunghezza pacchetto
COM stop bits Lunghezza bit di stop

Connettere il dispositivo IDom al bus via interfaccia seriale (RS232 o convertitore USB).

IDOM EVO - Per sapere la porta COM utilizzata aprire il Windows Device Manager, fare click su
Start > Control Panel > System > Device Manager.

o2 Gestione dispositivi

File Azione Visualizza ?
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IDOMX - Per conoscere la porta COM utilizzata, aprire il browser e digitare 'URL della pagina di
amministrazione del dispositivo: http:// [[DOMX IP ADDRESS] /admin

Fare click sulla scheda Network dove sono mostrati i dispositivi collegati via USB.



Modbus TCP/IP (Ethernet)

Configurare | seguenti parametri:

DRIVERS > MODBUS

IP address

Indirizzo IP dell’interfaccia Modbus

IP port

Porta TCP/IP dell’interfaccia Modbus

CONFIG. PUNTI

In aggiunta ai parametri ID e Nome e necessario compilare altri campi. | campi sono mostrati
disponibili in base al tipo di punto definito.

Nel caso di utilizzo contemporaneo di Modbus RTU e Modbus TCP/IP bisogna completare ciascuna

griglia con i relativi punti (una per i punti Modbus RTU tags, I’altra per quelli Modbus TCP/IP).

Address Indirizzo del registro modbus da leggere/scrivere
Type DI: digital input tag  DO: digital output tag

Al: analog inputtag  AO: analog output tag
Slave ID ID del modulo fisico
MinRaw Valore minimo RAW

(Disponibile solo per punti analogici input/output.)
Max Raw Valore massimo RAW

(Disponibile solo per punti analogici input/output.)
MinEu Valore minimo mostrato

(Disponibile solo per punti analogici input/output.)
MaxEu Valore massimo mostrato

(Disponibile solo per punti analogici input/output.)
Swap Bytes Ordinamento: little-endian / big-endian

Swap Bits

Ordinamento nella word: little-endian / big-endian
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Il dispositivo IDom in base alla tipologia di punto definita provvede ad assegnare il relativo
indirizzo del registro: coil, digital inputs, analogue inputs, holding register.

definire Nel caso di utilizzo contemporaneo di Modbus RTU e Modbus TCP/IP bisogna completare
ciascuna griglia con i relativi punti (una per i punti Modbus RTU tags, 'altra per quelli Modbus

TCP/IP).

Tipo punto Start indirizzi registro
DO (coil outputs) 00000

indirizzo = 3 (IDom) - indirizzo Modbus 00003
DI (digital in.) 10000

Indirizzo = 3 (IDom) = indirizzo Modbus 10003
Al (analogin.) 30000

Indirizzo = 3 (IDom) = indirizzo Modbus 30003
AO (holding reg.) 40000

Indirizzo = 4 (IDom) = indirizzo Modbus 40003




CONFIG. AMBIENTI
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Di seguito sono elencati alcuni controlli disponibili per I'interfaccia utente.

DISPLAY ANALOGICO

Item

Name

Position

User command

Selezionare =

Selezionare >

Tag Selezionare >
[...]

CROMOLED CONTROLLER
Item Selezionare 2>
Name
Position

User command

Tag

Selezionare >

Fare click 2>

Display
Test
Display Crea un display che mostra il
Analogico valore corrente ed allo stesso
tempo permette di modificarlo.
MOD4AO1 ID del punto
(Example: MOD4AO1)
RGB
RGBLed
SliderRGB Interfaccia standard per la

gestione delle striscie RGB a
led
(colore ed intensita luce)

Apre la finestra
di configurazione

Selezionare i punti
precedentemente configurati.

Example

Intensity: MB4TAG1
Red: MB4TAG2R
Green: MB4TAG3G
Blue: MB4TAG4B
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ENOCEAN

Ciascun dispositivo EnOcean prevede uno specifico profilo (modello) che contiene informazioni sul

formato dei dati e protocollo. La compatibilita € garantita con i soli moduli elencati di seguito.

Eltako
FSR61-230V

Attuatore wireless.
Relé passo-passo e monostabile

Eltako
FUD61NPN-230V

Attuatore wireless.
Dimmer universale per carichi R,L,C, LED230V
dimmerabili e lampade

Eltako
FSB61NP-230V

Attuatore wireless.
Rele per avvolgibili e componenti d’'ombreggiamento.

Schneider
LSS10020032

Sensore wireless
Contatto magnetico porta-finestra

Schneider
LSS10020048

Pulsante
Comando singolo

Eltako
FT55-rw

Pulsante
Comando singolo

Per prima cosa e necessario configurare il driver:

CONFIG. DRIVER

EnOcean (radio)

Tipo

EnOcean (radio)

Indirizzo IP

Default: 127.0.0.1 (macchina locale)
Parametro non modificale

Porta IP

Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.
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CONFIG. DISPOSITIVO

| dispositivi che permettono di comunicare con i dispositivi EnOcean marca Eltako sono i seguenti:

EnOcean Chiave USB con modulo radio IDOM EVO
USB 300/300C/300U integrato 868MHz, 315/902 MHz

EnOcean Scheda elettronica radio 868MHz IDOMX
Pl 868 RF Module, ASK installata internamente al dispositivo.
transceiver 868MHz

Il parametro da configurare & la porta COM utilizzata dal dispositivo.

COM Port Porta COM utilizzata dalla scheda radio interna di IDom.
(per sistema IDomX, default: 1)
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CONFIG. PUNTI

Per tutte le operazioni sui dispositivi fare riferimento alle istruzioni fornite in dotazione. La
seguente procedura € compatibile con i modelli elencati precedentemente.

Una volta configurate le voci driver e dispositivo ricordarsi di riavviare i servizi di A
sistema, dal menu: Strumenti > Riavvia DBE

Per funzionare correttamente il driver richiede che sia configurato un tag di A
servizio nella pagina punti. Nel caso quest’ultimo non sia presente procedere:

- Aprire il software di configurazione IShapeX alla pagina PUNTI.

- Inserire nella prima riga vuota un punto di tipo: SERVICE, denominato ad
esempio: serv.

- Riavviare i servizi di sistema.

E molto importante non cancellare mai questo punto.

Primi passi comuni a tutti i dispositivi:

1. Collegare il dispositivo alla rete elettrica (se attuatore). Assicurarsi che la memoria sia stata
cancellata e che siano attivati i telegrammi di conferma. Configurarlo normalmente per
interagire con la rete di pulsanti e sensori Eltako. Assicurarsi che il supervisore IDom sia
acceso, in modo da che possa gia leggere i pacchetti trasmessi in rete.

2. Dal browser accedere alla pagina di configurazione: [INDIRIZZO IP]/idom/enocean.php

Da qui e possibile monitorare i messaggi inviati dai vari dispositivi, ed effettuare le azioni di
comando necessarie in fase di apprendimento.

Fare click sul pulsante Clear list of discovered devices per cancellare le righe e partire per
una nuova acquisizione.

La procedura ora cambia in base alla tipologia di dispositivo da configurare.
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AGGIUNGERE DISPOSITIVO - FSR61

3. Premere il pulsante fisico che gestisce il rele, in modo tale da visualizzare nella pagina web
([INDIRIZZO IP]/idom/enocean.php) il codice del dispositivo. La voce SourcelD della
tabella corrisponde al codice identificativo del rele (vedere etichetta sul retro del
dispositivo).

4. Completare la colonna Desc (descrizione) relativa al modulo. Ad esempio “attuatore
soggiorno”. Tale descrizione sara la medesima visualizzata nella pagina punti di IShapeX.
Completare la colonna Model (modello) selezionando la sigla del codice, in questo caso
sara: FSR61INP-230V.

5. Fare click su Operation, selezionare SAVE poi fare click sul pulsante EXEC per salvare il
punto nel database di IDom.

NOTA: le righe senza descrizione e modello non sono aggiunte in IShapeX.
6. Dal software IShapeXX, riavviare i servizi di sistema: Strumenti > Riavvia DBE.
7. Apprendere il supervisore IDom:

¢ Selezionare 2 sul selettore in basso dell’attuatore. Poi selezionare LRN sul selettore
in alto. Il led comincia a lampeggiare.

* Nella pagina del browser, fare click sulla voce Operation e selezionare LRNOFF.
Fare poi click su exec per inviare il comando. Il led sull’attuatore smettera di
lampeggiare, segnale che & stato correttamente configurato I'OFF.

* Selezionare o= (infinito) sul selettore in basso dell’attuatore. Poi selezionare LRN sul
selettore in alto. Il led comincia a lampeggiare.

* Nella pagina del browser, fare click sulla voce Operation e selezionare LRNON.
Fare poi click su exec per inviare il comando. Il led sull’attuatore smettera di
lampeggiare, segnale che & stato correttamente configurato I'ON.

8. Dal software IShapeX, impostare un controllo Luce ON/OFF ed associare a queto il punto
creato precedentemente. Poi provare a comandarlo dall’interfaccia web.
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AGGIUNGERE DISPOSITIVO - FUD61NPN

3. Premere il pulsante fisico che gestisce il rele, in modo tale da visualizzare nella pagina web
([INDIRIZZO IP]/idom/enocean.php) il codice del dispositivo. La voce SourcelD della
tabella corrisponde al codice identificativo del rele (vedere etichetta sul retro del
dispositivo).

4. Completare la colonna Desc (descrizione) relativa al modulo. Ad esempio “attuatore
soggiorno”. Tale descrizione sara la medesima visualizzata nella pagina punti di IShapeX.
Completare la colonna Model (modello) selezionando la sigla del codice, in questo caso
sara: FUD61INPN-230V.

5. Fare click su Operation, selezionare SAVE poi fare click sul pulsante EXEC per salvare il
punto nel database di IDom.

NOTA: le righe senza descrizione e modello non sono aggiunte in IShapeX.
6. Riavviare i servizi di sistema: Strumenti > Riavvia DBE.
7. Apprendere il supervisore IDom:

a. Selezionare AUTO sul selettore in basso dell’attuatore. Poi selezionare LRN sul
selettore in alto. Il led comincia a lampeggiare.

b. Nella pagina del browser, fare click sulla voce Operation e selezionare LRNDIMMER.
Fare poi click su exec per inviare il comando. Il led sull’attuatore smettera di
lampeggiare, segnale che e stato correttamente configurato.

8. Impostare un controllo di tipo Luce Dimmer nelle pagine ambienti di IShapeX e provare a
comandarlo.
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AGGIUNGERE DISPOSITIVO - FSB61NP

3. Premere il pulsante fisico che gestisce il rele, in modo tale da visualizzare nella pagina web
([INDIRIZZO IP]/idom/enocean.php) il codice del dispositivo. La voce SourcelD della
tabella corrisponde al codice identificativo del rele (vedere etichetta sul retro del
dispositivo).

4. Completare la colonna Desc (descrizione) relativa al modulo. Ad esempio “attuatore
soggiorno”. Tale descrizione sara la medesima visualizzata nella pagina punti di IShapeX.
Completare la colonna Model (modello) selezionando la sigla del codice, in questo caso
sara: FSB61NP-230V.

5. Fare click su Operation, selezionare SAVE poi fare click sul pulsante EXEC per salvare il
punto nel database di IDom.

NOTA: le righe senza descrizione e modello non sono aggiunte in IShapeX.
6. Riavviare i servizi di sistema: Strumenti > Riavvia DBE.
7. Apprendere il supervisore IDom:

a. Selezionare MAX sul selettore in basso dell’attuatore. Poi selezionare LRN sul
selettore in alto. Il led comincia a lampeggiare.

b. Nella pagina del browser, fare click sulla voce Operation e selezionare LRNAUTO.
Fare poi click su exec per inviare il comando. Il led sull’attuatore smettera di
lampeggiare, segnale che e stato correttamente configurato.

8. Impostare un controllo di tipo KNX BT Automatismi nelle pagine ambienti di IShapeX e
provare a comandarlo.

AGGIUNGERE DISPOSITIVO — CONTATTO PORTA/FINESTRA

1. Far commutare il sensore da uno stato all’altro (esempio chiudere/aprire la finestra), in
modo tale da visualizzare nella pagina web ([INDIRIZZO IP]/idom/enocean.php) il codice
del dispositivo. La voce SourcelD della tabella corrisponde al codice identificativo del rele
(vedere etichetta sul retro del dispositivo).

2. Completare la colonna Desc (descrizione) relativa al modulo. Ad esempio “sensore finestra
soggiorno”. Tale descrizione sara la medesima visualizzata nella pagina punti di IShapeX.
Completare la colonna Model (modello) selezionando la sigla del codice.

3. Fare click su Operation, selezionare SAVE poi fare click sul pulsante EXEC per salvare il
punto nel database di IDom.
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NOTA: le righe senza descrizione e modello non sono aggiunte in IShapeX.
3. Riavviare i servizi di sistema: Strumenti > Riavvia DBE.

4. Impostare un controllo di tipo Allarme nelle pagine ambienti di IShapeX.

RIMUOVERE / MODIFICARE UN DISPOSITIVO

Dalla pagina web EnOcean per eliminare un punto e sufficiente togliere la descrizione dalla riga
corrispondente. In IShapeX chiudere e riaprire la pagina punti

Da IShapeX invece é sufficiente seguire la normale procedura.

La riga e rimossa sia dalla pagina punti di IShapeX sia dalla pagina web di configurazione EnOcean.
Di fatto entrambe le pagina sono sincronizzate,

Dopo ogni inclusione/esclusione di dispostivi € importante riavviare i servizi di A
sistema, via Strumenti > Riavvia DBE.net

La lettura della rete, I'aggiornamento e |'acquisizione dei dispositivi sono procedure
che possono richiedere anche alcuni minuti per il completamento. Non c’é
segnalazione all’'utente sul termine della procedura.
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SIMPLE HOME - COMELIT

Per comunicare con i dispositivi appartenenti al bus Comelit bisogna utilizzare:

SimpleHome (seriale)

CONFIG. DRIVER

Tipo SimpleHome (seriale)

Porta IP Porta TCP/IP impiegata. Parametro compilato in
automatico. Nel caso si volesse impostare
manualmente scegliere una porta libera, non
utilizzata da altri drivers.

CONFIG. DISPOSITIVO

Si prosegue a configurare il dispositivo.

COM port Numero della porta COM (seriale) utilizzata.
COM baudrate Velocita bit/s della porta COM (seriale) utilizzata
COM parity Tipo di parita della comunicazione COM (seriale)

Default: NONE

COM data bits Lunghezza del dato in bit
Default: 8

COM stop bits Lunghezza dello stop in bit
Default: 1

Nel caso di macchina IDom EVO, quest’ultima pud connettersi direttamente al convertitore del
BUS via porta seriale RS232 localizzata sul retro del dispositivo. Nel caso di sistema IDomX
bisognera utilizzare un convertitore USB-Seriale.
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Per conoscere la porta COM utilizzata nei sistemi IDom EVO bisogna accedere al gestore dispositivi
di Windows (Pannello di Controllo > Sistema > Gestione Dispositivi).
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Viceversa nel caso di dispositivi IDomX bisogna collegarsi via web browser alla pagina di
amministrazione ( http:// [INDIRIZZO IP IDOMX] /admin) e fare click sulla voce Devices.

-lolx
8% Devices x

| € | @ 192.168.100.144/zdmin/devices himl
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| Domee

Network  Password  Devices | Update  Modem

Devices

List of connected devices:
Code Description

ttyUsB1  Prolific Technology Inc. USB-Serial Controller-if00-port0

———————————

La numerazione delle porte nei sistemi IDomX comincia dalla COMO ed ¢ differente
rispetto ai sistemi IDom EVO basati su Windows.

Ricordarsi di incrementare di +1 il numero della porta COM letto su IDomX.
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CONFIG. PUNTI

In aggiunta ai parametri ID e Nome & necessario compilare altri campi. | campi sono mostrati
disponibili in base al tipo di punto definito.

Indirizzo Indirizzo dell’uscita all’interno del modulo SimpleHome.

Tipo Sono disponibili le seguenti uscite:

DO - Funzione: forzatura — Uscite digitali LUCE

DO - Funzione: normale — comandi TAPPARELLA su/giu
AO - Funzione: normale — Dimmer

AO - Funzione: carichi = ND

Al - Funzione: normale - Ingresso analogico

Al - Funzione: forzatura — Temperatura

TZONA - Funzione: normale — ND

TZONA - Funzione: forzatura — ND

TAG SERVIZIO - Necessario configurare un punto di
guesto tipo per ogni driver.

Funzione Normale
Forzatura (imposta direttamente |'uscita del modulo)
Carichi

Slave ID Indirizzo del modulo Simple Home.

Sonda Selezionare la voce solamente per moduli di tipo sonda

(non per termostati)

I punti di tipo AO richiedono la specifica dell’intervallo RAW ed EU. Ad esempio per
un dimmer potrebbero essere: -_

MinRaw = 50
MaxRaw = 255
MinEu = 0
MaxEu = 100

E necessario configurare un punto di tipo TAGSERVIZIO al fine del corretto A
funzionamento e comunicazione sul bus.
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CONFIG. AMBIENTI

Di seguito sono elencati alcuni controlli particolari.

CONTROLLO LUCE

Controllo Selezionare =

Nome

Posizione

Comando utente Selezionare >

Punto Selezionare >
[...]

CONTROLLO DIMMER
Controllo Selezionare =
Nome
Posizione

Comando utente Selezionare =

Punto Selezionare =

Luce

L1 Sala

ON/OFF

PuntolL1 ID del punto Iluce
dimmer configurato.
(Esempio: PuntoL1)

Luce

Dimmer salotto

Slider

LuceDim1 ID del punto configurato
come AO, modulo dimmer.

(Esempio: LuceDim1)



CONTROLLO TAPPARELLA
Controllo Selezionare >
Nome
Posizione

Comando utente

Punto

[ ]

Selezionare >

Fare click =

Automatismi

Tenda cucina
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Su/Giu

Apre la finestra
di configurazione

Selezionare dall’elenco il
punto DO che effettua
I'apertura e quello della
chiusura.
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FUNZIONI AVANZATE
SCRIPT

Al fine di estendere le possibilita di controllo e supervisione & possibile scrivere dei programmi in
linguaggio LUA (v5.1). Tali programmi possono essere eseguiti ad ogni cambio di stato dei punti
dell'impianto.

Per maggiori informazioni sulla programmazione si rimanda al manuale del linguaggio “LUA 5.1”.

EDITOR

Per accedere all’editor selezionare: Configura > Script editor.

BE 2> o=

el all|LUCE_DA_SP350 ~| Esequiall'avvio -

local pointl = "DOOS™
local statel = VarGetValue (pointl)

VarSetValue ("TBDCO4™, statel)

Le icone in alto a sinistra gestiscono I’elenco dei dispositivi:

Nuovo

Salva

Annulla modifiche

Elimina script corrente

Chiude finestra

BEO U DD

Esegui all’avvio Se selezionato: lo script viene eseguito
all’lavvio di IDom oltre ad essere
associato ad un cambiamento di stato di
un punto.

Script Elenco degli script creati
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FUNZIONI LUA

Per utilizzare i punti della rete domotica all'interno degli script LUA, € necessario utilizzare le
seguenti funzioni:

dato = VarGetValue(“ <id punto> ")
Assegna il valore del punto <id punto> alla variabile dato

Esempio
luce01l = VarGetValue(“knxLight01")

VarSetValue(“ <id punto>”, “ <valore> ")

Assegna <valore> al punto denominato <id punto>
Esempio

luce0l =1

VarSetValue(“knxLight01”, luce01)

Esempio
VarSetValue(“knxLight02”, “1")

Una seconda funzione permette di attivare I'esecuzione di uno scenario.

StartScenario(“ <nome scenario> ")

Parte I’esecuzione dello scenario denominato <nome
scenario>

Esempio
StartScenario("ChiusuraVacanze”)
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ESEMPIO

In base al valore della variabile giorno e presenza si comanda |'alzata/abbassata di una tapparella
e 'accensione/spegnimento di una luce.

ID Punto Descrizione Tipo

SensLuce Sensore di luminosita DI
[1=luminoso, O=buio]

SensPresenza Sensore di presenza DI
[1=occupato, O=nessuno]
TapSU Comando sul motore, alza tapparella DO
TapGIU Comando sul motore, abbassa tapparella DO
Lucel Punto luce DO
LUA Script

local giorno = VarGetValue("SensLuce”)
local presenza = VarGetValue("SensPresenza”)
if presenza=="1" then
if giorno=="1" then
VarSetValue("TapSu”,”1")
VarSetValue(“Lucel”,”0")
else
VarSetValue("TapGIU”,"1")
VarSetValue(“Lucel”,"1")
end
end




FUNZIONI AVANZATE > VARIABILI INTERNE

VARIABILI INTERNE

E possibile configurare una serie di grandezze utilizzate da IShapeX per estendere la configurabilita
dell’ambiente di configurazione.

FINESTRA VARIABILI INTERNE

Selezionare: Configura > Variabili interne.
Si apre una finestra con |'elenco delle variabili configurate.

Le icone in alto a sinistra gestiscono la finestra:

Salva

U @

Annulla modifiche

Elimina script corrente

Chiude finestra

L %]

Fare click sulle celle per modificare i parametri.

ID Variabile Stringa alfanumerica univoca identificativa della variabile.
Descrizione Descrizione della variabile
Tipo DI: ingresso digitale / DO: uscita digitale

Al: ingresso analogico / AO: uscita analogica

Origine Dati Associa un punto della rete domotica
Bit [Parametro non utilizzato]
Script Associa l'esecuzione di uno script al cambiamento del

valore della grandezza

Valore Min Soglia valore minimo

Valore Max Soglia valore massimo

Note Campo libero per appunti
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PARAMETRI DEL PROGETTO

Ciascun progetto contiene una serie di impostazioni e proprieta configurabili.

Selezionare: Configura > Parametri.

Si apre una finestra contenente una serie di schede. Fare click sulle voci desiderate ed apportare le

modifiche necessarie.

iShapeX 1.6.8.419 - 127.0.0.1 - TDOM Demo 146

File Configura Mappe Strumenti Finestre ?

P @B RN

Nome progetto

|1DOM Demo 146

In ogni scheda modificata fare subito click su OK, prima di spostarsi sulla A

seguente.
Spostarsi senza premere OK comporta la perdita automatica delle modifiche fatte.
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SCHEDA: DATI PROGETTO

Nome progetto: Nome del progetto corrente

SCHEDA: GESTIONE CARICHI

E possibile definire un limite di potenza assorbita (espresso in watt), oltre il quale appare una
segnalazione sull’interfaccia web.

Punto: punto definito nella rete

Limite carico: limite di potenza [watt]

SCHEDA: STILI GRAFICI

Selezionare il set di icone e colori utilizzato nell’interfaccia grafica.

SCHEDA: MULTIMEDIA

Per maggiori dettagli si consiglia di leggere il capitolo MULTIMEDIA del presente manuale.
Abilita file audio: se selezionato permette al driver audio di eseguire i files musicali

Cartella predefinita: directory predefinita files audio.

SCHEDA: LINGUA

Selezionare la lingua dell’interfaccia web di IDom, a scelta tra: italiano, inglese, russo, tedesco.

L'impostazione della lingua della finestra Parametri € slegata dalla lingua del
configuratore IShapeX (configurabile dal menu: File > Lingua ). -_
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SCHEDA: MAPPE

Configurazione dei parametri grafici — aspetto, della pagina mappe.
Dimensione icone: grandezza in px delle icone (default: 32)

Meteo ID: visualizza dati meteo. Per elenco delle citta italiane consultare I'appendice.
(Disattivo se: -1).

Colore sfondo: colore di sfondo pagina mappe. Si suggeriscono tonalita scure.

Logo: cambia il logo visualizzato in alto a sinistra. E possibile affiancare un logo utente
personalizzato.

Carica logo: aggiunge un logo utente personalizzato. Utilizzare immagini con estensione
.png e dimensioni massime 220x50px).

Scritta tra logo IDom e cliente: eventuale testo tra i loghi

SCHEDA: TEMPLATE

E possibile importare/esportare il template dei controllo personalizzati di tipo pagina generica, o
termostato.

SCHEDA: DATALOGGER
E possibile configurare una rete di dispositivi remoti IDomX ed un collettore di dati, IDom (master).

| dispositivi remoti raccologono i dati a livello locale, poi provvedono ad inviarli all’unita master.

I dati sono accessibili via interfaccia web facendo click sull’icona del DatalLogger
nella sezione admin. -—
La visualizzazione dei dati € in griglia o in forma di grafici.

E possibile esportare i dati raccolti su file .csv




FUNZIONI AVANZATE > PARAMETRI DEL PROGETTO

Modalita Master Se selezionato: il dispositivo diventa un
collettore di dati.
(Solo per dispositivi IDom)

Modalita Remoto Se selezionato: il dispositivo diventa un
raccoglitore di dati.
(Solo per dispositivi IDomX)

Indirizzo Master Indirizzo IP macchina Master (collettore)

Intervallo invio eventi  Tempo, espresso in secondi, oltre al quale
invia i dati evento al Master

Intervallo invio allarmi  Tempo, espresso in secondi, oltre al quale
invia i dati allarme al Master

Mantieni storico per Numero di giorni per cui sono tenuti in
memoria i dati acquisiti.

Non tutte le licenze IDom hanno abilitata la funzione datalogger.
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NOTIFICHE

Allo scatenarsi di determinati eventi e possibile inviare una serie di notifiche via SMS ed email ad
un elenco di persone.

DESTINATARI

Selezionare: Configura > Notifiche > Destinatari.

Nome Nome del destinatario

Numero Cell. Numero del recapito mobile destinatario
Esempio: 1112345678

Indirizzo Indirizzo email destinatario
Esempio: nome@provider.abc

AZIONI

Configura un tipo di notifica (azione da intraprendere) ed il destinatario a cui associarla.

Selezionare: Configura > Notifiche > Azioni.

Non attiva Se selezionato rende disattiva
Nome Nome univoco dell’azione
Tipo Canale delle notifiche:

EMAIL, SMS, LOG (locale del sistema)

Destinatari Selezionare il destinatario

Etichetta Tag Etichetta personalizzata nei log. (Solo per
notifiche a livello di log).

Messaggio Testo incluso nella notifica

Note Campo libero per appunti
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REGOLE

Si configura la condizione sul punto che attivera le azioni di notifica.
Selezionare: Configura > Notifiche > Regole.

Selezionare dall’elenco Tags disponibili il punto dell'impianto su cui lavorare. Poi completare i

campi sulla griglia.

Azione Selezionare l'azione desiderata tra quelle
precedentemente configurate.

Operatore Condizione sul punto che scatenera I'evento.
Normalmente € un operatore di confronto.

Valore Campo su cui effettuare il confronto

C Cancella la riga corrente

PARAMETRI

Configurazione dei parametri per le notifiche. Per l'invio delle email si puo usare un qualsiasi
account email con server SMTP, mentre gli sms sono inviati tramite il portale Skebby.it e richiede
un utente registrato.

Selezionare: Configura > Notifiche > Parametri.

Engine System  DOM SYSTEM (default — non modificare)

E-mail Indirizzo mittente: indirizzo email mittente
Server SMTP: indirizzo del server
Porta SMTP: porta del server
Autenticazione: NONE oppure SSL/TLS
Utente: nome utente per accedere al server SMTP
Password: password per accedere al server SMTP

Sms Utente: nome utente registrato su Skebby.it
Password: password utente registrato su Skebby.it
Tipo SMS: send_sms_classic (default — non modificare)
Sender number: numero mobile dell’utente
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Se si configura come tipo di autenticazione: NONE, allora & necessario lasciare A
vuoti i campi sottostanti: Utente e Password.

MITTENTE
Per lI'invio delle email, i server compatibili devono essere SMTP. La porta standard -—
utilizzata & la 25 (in alcuni casi la 1725).

Il sistema non & compatibile con il server SMTP di Google Gmail.

DESTINATARI

Il sistema IDom invia le email ai destinatari configurati indipendentemente dal loro
provider, a patto pero che lindirizzo email sia attivo, sia scritto nel formato
corretto, e ci sia spazio sufficiente sul server della posta in arrivo.

Eventuali configurazioni anti-spam, regole di archiviazione, ... configurate dal
destinatario possono spostare, cancellare, archiviare, nascondere in automatico i
messaggi inviati da IDom. Controllare le proprie impostazioni software.
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APPENDICE A
ICONA METEO

Elencare ID numerici delle principali citta italiane.

Codice numerico

Disattivo -1

Milano 16066
Roma 16240
Palermo 16405
Napoli 16289
Firenze 16170
Bologna 16140
Bari 16270
Venezia 16105
Torino 16059
Reggio Calabria 16422
Trento 16022
Perugia 16181
Genova 16120
Aosta 16054
Trieste 16101
Ancona 16191
L’Aquila 16228
Campobasso 16252
Potenza 16300
Cagliari 16560

Se la citta desiderata non risulta in elenco contattare il Servizio Assistenza e Supporto di IDom.
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APPENDICE B

CONFIGURARE INDIRIZZO IP

IDom EVO  Indirizzo default: 192.168.1.123

IDomX Indirizzo default: 192.168.1.127

Connettere il dispositivo IDom ed il pc col quale si programmera il dispositivo sotto lo stesso
switch di rete (o router).

Aprire le finestra Centro connessioni di rete e condivisione dal pannello di controllo di Windows
(pc). Aggiungere un secondo indirizzo IP alla propria macchina, oppure sovrascrivere quello
attuale, avendo pero 'accortezza di scegliere un indirizzo con la stessa sottorete 192.168.1.xxx
(maschera 255.255.255.0) della macchina IDom. Nell’esempio: 192.168.40.

SWITCH SWITCH 192.168.5.40
00000 192.168.5.40 00000 192.168.1.40

[ ]

[ _
IDOM

192.168.1.123

-

192.168.1.123
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Ora i due dispositivi comunicano sulla stessa sottorete ed & possibile collegarsi al dispositivo IDom

e cambiarne I'indirizzo IP in base alla rete domotica configurata.

Per cambiare l'indirizzo IP della macchina IDom, la procedura si differenzia in base al modello.

SWITCH 192.168.5.40
BUS INTERFACE I 192.168.1.40

ethernet I

192.168.2.30

S -

IDOM EVO

192.168.2.123

SWITCH

192.168.5.40
BUS INTERFACE DDDDD 192.168.1.40
ethernet I D
|
192.168.18. 30
IDOMX

192.168.18.127

IDom
EVO

Connettersi al dispositivo attraverso
il software VNC.

Indirizzo: 192.168.1.123
Password: domovncl3

Il dispositivo EVO & una macchina
Windows a tutti gli effetti. Accedere
quindi al Centro connessioni di rete
e condivisione ed assegnare
I'indirizzo corretto.

Esempio: 192.168.2.123

IDomX

Connettersi al dispositivo semplicemente
digitando il seguente indirizzo nella
pagina di un browser web:

192.168.1.127/admin

Username: admin
Password: admin

Fare click sulla voce Network.
Riassegnare l'indirizzo IP e fare click su

Save.

Esempio: 192.168.18.127
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APPENDICE C

ESEMPI

KNX - TERMOSTATO

Si prende come riferimento il modulo Schneider MTN6241-0319 e si procede nella configurazione
del termostato.

Si aggiunge il driver e dispositivo richiesti. Poi si definiscono i punti necessari.

Punti
| 1D Nome Tipo | Indirizzo Comanda Indirizzo Stato | Mot

1 ;knxsp knx set point KNXAO_FLOAT 2/4/21 2/4/20

2 |knxstagione knx stagione KNXLUCE 2/4/100 2/4/101

3 [knxsvrisc knx stato valvola riscald KNXLUCE 2/4/102 2/4/102

4 fknxsvcund knx stato valvola condiz KNXLUCE 2/4/103 2/4/103

5 :knxmodo knx modo termo KNXBYTE_AOD 2/4/31 2/4/30(7)

6 |knxta knx temp ril KNXAI_FLOAT 2/4/10

Dalla pagine degli ambienti si aggiunge un controllo di tipo Termostato e si apre il configuratore.

Controlli ambiente

Controllo Nome Posizione Comando utente Punto .. | Scenari Pr
/ Termostato JTermoatato sala 1 Termostato generico J [l
1 =4 > '|
-
7

Si aggiungono i campi desiderati (fare click col pulsante destro sopra l'icona Termostato) e si
configurano i parametri di ciascun campo.
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Click pulsante destro. Selezionare: Add > Temperatura Ambiente.

Tipo controllo Temperatura ambiente (non modificabile)
Etichetta web Temperatura

Mostra in Pagina principale

Tag stato Knxta — knx temp ril

UM °C

Fattore di conversione 1

Cifre decimali 1

Click pulsante destro. Selezionare: Add > Stato valvole

Tipo controllo Stato Valvole (non modificabile)
Etichetta web Stato valvola

Tag stato riscaldamento Knxsvrisc — knx stato valvola riscald
Tag stato raffreddamento Knxsvcond — knx stato valvola condiz
Valore stato riscaldamento 1

Valore stato raffreddamento 1

Click pulsante destro. Selezionare: Add > Temperatura set point

Tipo controllo Temperatura set point
(non modificabile)

Etichetta web Set point

Mostra in Pagina principale

Tag stato Knxsp — knx set point
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Tag comando

Knxsp — knx set point

uUum °C
Fattore di conversione 1
Cifre decimali 1

Valore minimo

Si pu0 scegliere di associare un valore
minimo assoluto (statico) oppure farlo
dipendere da un’impostazione del
termostato (dinamico).

Valore massimo

Procedere come per valore minimo.

Step

0.5

Mostra controlli avanzati

Selezionata

Si sceglie di impostare un valore minimo dinamico. Fare click sul pulsante [...], si apre una seconda
finestra con un elenco di punti (Tags), ed una griglia con le soglie. Queste ultime, a seconda del
modo (che verra configurato tra poco), limitano l'utente nella configurazione di valori

massimi/minimi.

P
u Configuratore soglie MIN-MAX (Valore Minima)

Statica

© Dinamica

Tags
shdimmer2
shtermoSv
shiermoSeg
shitermoSen
shiermoSev
shtermoSmodo
shiermoSig
shiermoin
shtermoStr
shdimmer1
shdo(2
KNXSPTEST
lroamodo
krods
dmgdimm

(]

Blenco Sogie

Tag
lromodo
kroamodo
kroomodo
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Nella configurazione mostrata sopra I'utente non puo impostare un valore inferiore ad 11 gradi
(soglia=11) se si € in modalita Comfort (valore=1).

Si procede a configurare il Modo del termostato (comfort, notte, spento). Per farlo si crea un
gruppo, in modo da rendere dinamico il numero delle modalita e personalizzare le etichette.

Per convenzione essendo il primo gruppo creato si mette ID Gruppo ad 1. Il modulo prevede la
seguente convenzione numerica per gli stati attivi: 1-notte, 2-spento, 4-comfort. Invece per
guanto riguarda i valori di attivazione: 1-notte, 2-spento, 3-comfort.

Click pulsante destro. Selezionare: Add > Generico

Tipo controllo Generico (non modificabile)
Etichetta web Comfort

Mostra in Pagina principale

Tag stato Knxmodo — knx modo termo
Tag comando Knxmodo — knx modo termo
ID Gruppo 1

Etichetta Gruppo Modo

Valore stato attivo 4

Valore attivazione 3

Sola lettura Non selezionato
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Si ripete in modo analogo per gli altri due stati: notte e spento.

Tipo controllo Generico Tipo controllo Generico

Etichetta web Notte Etichetta web Spento

Mostra in Pagina principale Mostra in Pagina principale

Tag stato Knxmodo - knx Tag stato Knxmodo - knx
modo termo modo termo

Tag comando Knxmodo - knx Tag comando Knxmodo - knx
modo termo modo termo

ID Gruppo 1 ID Gruppo 1

Etichetta Gruppo Modo Etichetta Gruppo Modo

Valore stato attivo 1 Valore stato attivo 2

Valore attivazione 1 Valore attivazione 2

Sola lettura

Non selezionato

Sola lettura

Non selezionato

Si procede col definire una modalita di stagione: inverno, estate, che verra visualizzata nella pagina
web specifica del controllo (Pagina avanzata). Anche stavolta si impiegano i gruppi. Essendo il
secondo gruppo creato si mette ID Gruppo ad 2. Il modulo prevede la seguente convenzione
numerica per gli stati attivi: 0-estate, 1-inverno. Per quanto riguarda i valori di attivazione: O-
estate, 1-inverno.

Click pulsante destro. Selezionare: Add > Generico

Generico
Inverno

Pagina avanzata
Knxstagione -
knx stagione
Knxstagione -
knx stagione

ID Gruppo 2

Etichetta Gruppo Modo

Valore stato attivo 1

Valore attivazione 1

Sola lettura Non selezionato

Generico

Estate

Pagina avanzata
Knxstagione -
knx stagione
Knxstagione -
knx stagione

ID Gruppo 2

Etichetta Gruppo Modo

Valore stato attivo O

Valore attivazione 0

Sola lettura Non selezionato

Tipo controllo
Etichetta web
Mostra in
Tag stato

Tipo controllo
Etichetta web
Mostra in
Tag stato

Tag comando Tag comando

Il controllo & configurato e pronto per essere usato nell’interfaccia web.
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APPENDICE D

Per maggiori informazioni riguardo la programmazione in linguaggio LUA si rimanda a:

www.lua.org/manual/5.1/
lua-users.org/wiki/TutorialDirectory

LUA SCRIPTS

1 - LAVAGGIO INTELLIGENTE

Attivazione di un’utenza lavatrice quando I'energia prodotta & superiore ad una soglia di

produzione fissata.

ID Punto Descrizione

VAOO03 Produzione attuale [W]

VD002 Abilitazione presa corrente lavatrice
VAOO01 Soglia max per attivazione [W]
VAOO02 Soglia min per disattivazione [W]
VD001 Pulsante abilita(=1)/disabilita logica

LUA Script

local CorrWTag = "VAOO03"

local UtenzaTag = "VDO02"

local LMaxTag = "VAOO01"

local LMinTag = "VAOQ02"

local ForzaturaTag = "VDOO1"

local CorrW = VarGetValue(CorrWTag)

local LMax = VarGetValue(LMaxTag)

local LMin = VarGetValue(LMinTag)

local LogicaAttiva = VarGetValue(ForzaturaTag)

if LogicaAttiva == "1" then
if (tonumber(CorrW) > tonumber(LMax)) then
VarSetValue(UtenzaTag, "0")
end
if (tonumber(CorrW) < tonumber(LMin)) then
VarSetValue(UtenzaTag, "1")
end
end
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2 — CREAZIONE PAGINA WEB

Crea una pagina web contenente il valore di un punto del bus.

ID Punto Descrizione

DI_123 Ingresso digitale generico

LUA Script

local NomePunto = 'DI_123'
local ValorelDPunto = VarGetValue(NomePunto)

-- indirizzo per o.s. windows
local IndirizzoFile = "\program files\omnicon”

IndirizzoFile = IndirizzoFile ..\idom\webapp\esemp io.html"
locals ="
s = s ..'<htmI><head><title>IDom Test Script</title >

s = s ..'<meta http-equiv="refresh" content="5">"
s = s ..'</head><body>'

s = s ..'<h2>Esempio di pagina generata dinamicamen te</h2>'

s =s..'p: <b>"..NomePunto..'</b>, val: <b>'..Valo reIDPunto..' </b>'
s = s ..'la pagina si ricarica ogni 5 secondi<br/>'

s = s ..'<i>ultimo aggiornamento "..0s.date()..'</i >

s = s ..'</body></htm|>'
-- file aperto in scrittura "w"

fileA = io.open(IndirizzoFile, "w")
io.output(fileA)

io.write(s)

io.close()

-- metodo alternativo per scrivere il codice
-- fileA = io.open(IndirizzoFile, 'w")

-- fileA:write(s)

-- fileA:close()

In questo esempio, la pagina e raggiungibile: http:// [indirizzo IP] /idom/esempio.html|



APPENDICE D > LUA SCRIPTS

3 — ESECUZIONE COMANDI SU 0.S. WIN

Esegue uno script batch che invia un’email allegando un testo.

ID Punto Descrizione
VManageRW
VRWZoneO1

LUA Script

local Manage = VarGetValue("VManageRW")
local Rval = VarGetValue("VRWZone01")
io.output(io.open(“/testlog.txt", "w"))
io.stdout:setvbuf('no’)
io.write("eseguito script")
io.close()
if Manage == "1" then
if RvVal =="1" then
-- un batch che invia email con allegato
os.execute("C:\\testcam\\sendjpg.cmd")
io.output(io.open("/testlog.txt", "w"))
io.stdout:setvbuf('no’)
io.write("eseguito comando")
io.close()
end
end
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4 — PRELIEVO DATI SU TAG COMPOSTO

Preleva il valore di energia, separando il valore totale da quello istantanei.

ID Punto Descrizione

PCAXBNy Punto contatore energia
Powerl Variabile interna
HistPowerl Variabile interna

LUA Script

local pntEnergy = VarGetValue("PCAxXBNy")

-- Separa il valore totale dal valore istantaneo

local values = {}

for value in string.gmatch(pntEnergy, "(%d+[.]%d*)" ) do
tmpValue = tonumber(value)
if tmpValue == nil then tmpValue = 0 end
table.insert(values, value)

end

-- Assign splitted values to internal vars

-- Assegna i valori separati in precedenza alle var iabili interne
VarSetValue("Powerl", values[2])

VarSetValue("HistPowerl", values[1])
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APPENDICE E

RISOLUZIONE PROBLEMI

SOFTWARE ISHAPEX

Connessione

- Non si connette al dispositivo ed un messaggio di errore appare su schermo.
“Errore nell’accesso al database. Unable to complete network request to host “xx.xx.xx.xx”

L'indirizzo IP del dispositivo a cui ci si vuole connettere € errato, oppure il dispositivo non &
raggiungibile dalla rete locale. Verificare gli indirizzi IP, la configurazione della rete locale ed i
cablaggi.

Drivers
- Il driver seriale non comunica correttamente.

Verificare che la porta COM configurata sia la stessa rilevata dal sistema operativo. Nel caso di
convertitori USB/seriale (FTDI chip), il fatto di scollegare/collegare I’adattore riassegna il numero
della porta COM.

Punti — Importazione punti centrale allarme INIM
= Alcune aree e/o sensori non vengono importati, mancano dalla lista.

Per una corretta importazione tutti i terminali della centrale vanno lasciati mappati (Esempio:
lasciare mappati i 50 terminali per la centrale 1050). E’ importante non eliminare i terminali anche
se non utilizzati (scollegati).

Punti — BUS
= Alcuni punti non sono mostrati nella griglia o nei ment a tendina.

Ricordarsi di riavviare i servizi di sistema: Strumenti > Riavvia DBE.net
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Punti, Ambienti — Griglia valori
= Alcuni valori scritti nella griglia (tabella) non vengono salvati.

Ciascun campo nella griglia va confermato tramite il tasto INVIO o in alternativa, dopo la modifica,
bisogna spostarsi su una cella vicina.

Riavvio DBE.net
- Errore

Ciascun campo nella griglia va confermato tramite il tasto INVIO o in alternativa, dopo la modifica,
bisogna spostarsi su una cella vicina.
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INTERFACCIA UTENTE

Visualizzazione
= Collegandosi all’indirizzo del dispositivo IDom non é visualizzato alcun elemento grafico.

Ricontrollare che l'indirizzo dell’URL sia corretto, e verificare di disporre di collegamento rete
locale e/o internet sul dispositivo utilizzato.
Verificare di aver abilitato i cookie sul browser utilizzato per la navigazione web.

Accesso remoto

- Utilizzando I'URL del servizio MylDom nel browser web o tramite app richiede le credenziali di
accesso ma una volta inserite dichiara “Nome utente o password errati” e richiede nuovamente
I'immissione.

Ricontrollare attentamente i caratteri digitati.

Su dispositivi mobili potrebbero essere attive opzioni di completamente automatico, prima lettera
maiuscola, o inserimento automatico spazi/punteggiatura. Controllare la propria configurazione e
disattivarle se attive.

Nome utente e password sono modificabili collegandosi via rete locale LAN all’indirizzo del
dispositivo (Esempio 192.168.1.127). Nella pagina Impostazioni dell’interfaccia grafica.

= Collegandosi con un secondo dispositivo o aprendo finestre multiple sul browser il sistema
awvisa che si e raggiunto il numero massimo di utenti.
[Nelle versioni precedenti di IDom il numero di utenti connessi era limitato]

Verificare nelle impostazioni del browser che siano abilitati i cookies per la navigazione, in modo
tale che IDom riconosca che € sempre lo stesso browser (e lo stesso utente) che sta accedendo
alle pagine.
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SUPPORTO

Per supporto tecnico relativo ai prodotti IDom, contattare:
Email: support@idom.it

Telefono: (+39) 0362 830037

Assistenza tecnica telefonica dal Lunedi al Venerdi 9:00 - 13:00

Per informazioni generali, contattare:

Email: inffo@omnicon.it



